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About this Documentation

Document Conventions
Convention Description
Bold Identifies elements on a screen.

Monospace font

Identifies service names and locations in the format folder.subfolder.service,
APIs, Java classes, methods, properties.

Italic

Identifies:

Variables for which you must supply values specific to your own situation or
environment.

New terms the first time they occur in the text.

References to other documentation sources.

Monospace font

Identifies:

Text you must type in.
Messages displayed by the system.
Program code.

Indicates a set of choices from which you must choose one. Type only the information
inside the curly braces. Do not type the { } symbols.

Separates two mutually exclusive choices in a syntax line. Type one of these choices.
Do not type the | symbol.

Indicates one or more options. Type only the information inside the square brackets.
Do not type the [ ] symbols.

Indicates that you can type multiple options of the same type. Type only the
information. Do not type the ellipsis (...).

Online Information and Support

Product Documentation

You can find the product documentation on our documentation website at https://documenta-
tion.softwareag.com.

In addition, you can also access the cloud product documentation via https://www.software-
ag.cloud. Navigate to the desired product and then, depending on your solution, go to “Developer
Center”, “User Center” or “Documentation”.

Product Training

You can find helpful product training material on our Learning Portal at https://knowledge.soft-

wareag.com.
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About this Documentation

Tech Community

You can collaborate with Software AG experts on our Tech Community website at https://tech-
community.softwareag.com. From here you can, for example:

® Browse through our vast knowledge base.

" Ask questions and find answers in our discussion forums.

Get the latest Software AG news and announcements.

Explore our communities.
® Go to our public GitHub and Docker repositories at https://github.com/softwareag and ht-
tps://hub.docker.com/publishers/softwareag and discover additional Software AG resources.

Product Support

Support for Software AG products is provided to licensed customers via our Empower Portal at
https://empower.softwareag.com. Many services on this portal require that you have an account.
If you do not yet have one, you can request it at https://empower.softwareag.com/register. Once
you have an account, you can, for example:

® Download products, updates and fixes.

® Search the Knowledge Center for technical information and tips.

" Subscribe to early warnings and critical alerts.

Open and update support incidents.

Add product feature requests.

Data Protection

Software AG products provide functionality with respect to processing of personal data according
to the EU General Data Protection Regulation (GDPR). Where applicable, appropriate steps are
documented in the respective administration documentation.
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Introduction to the XML/SOAP Wrapper

The EntireX XML/SOAP Wrapper enables XML-based communication to EntireX/Natural RPC
servers and communication from EntireX/Natural RPC clients to XML-based servers.

XML/SOAP Wrapper Concepts

The EntireX XML/SOAP Wrapper and the RPC Server for XML/SOAP enable XML-based commu-
nication via XML/SOAP Wrapper. An EntireX RPC server or a Natural RPC Server can communicate
with XML-based clients. Similarly, an EntireX RPC client or Natural RPC client can communicate
with an XML-based server via RPC Server for XML/SOAP. EntireX participants (client or server)
with an XML-based application (server or client) can be easily integrated with the Software AG
Designer and the EntireX XML/SOAP Wrapper/ RPC Server for XML/SOAP.

The XML Mapping File is an XML file (file extension .xmm) generated by the EntireX XML Mapping
Editor and used by the EntireX XML/SOAP Runtime, to map between XML documents and En-
tireX/Natural RPC parameters.

Communication is synchronous.

EntireX
Servers 4 > Kibesed.
XML/SoAP 4
R > Runtime -
Clients «— - p-m;;::f:d-

XML-based Clients Calling EntireX/Natural RPC Servers

The XML-based client sends an XML document to EntireX XML/SOAP Runtime.

From an incoming XML document, the EntireX XML/SOAP Runtime extracts (using the mapping
file) the information necessary to call an EntireX/Natural RPC server. It executes the RPC. The
result returned by the EntireX/Natural RPC server is used to create an outgoing XML document.

The XML-based client gets an XML document containing the response.

Mapping example: calc

6 EntireX XML/SOAP Wrapper



Introduction to the XML/SOAP Wrapper

Incoming XML Document

<7xml version ="1.0" encoding="utf-8" 7=

<CALC= _
<Operation=+ ::J'Dperaucun:- ;\.\
<Operand_1> <Operarid_1> _ T i
e .
<Operand_2»222223222<[Qperand 2> “w,\
<ICALC> N
o Call | \
v v v
result = myTest.calc ( operation , ,operand 2
_/f"

Resulting XML Document /

s
A
F

<7xml version ="1.0" enc,p:-’ﬂ ing="utf-8" 7=
7

<CALC>
|

<Result=555555555</Result>

=/CALC= e

A mapping editor is provided to map the XML structures to those of the server application.

EntireX/Natural RPC Client Calling XML-based Servers

The RPC client sends a request to the RPC Server for XML/SOAP. The RPC Server for XML/SOAP
translates (using the mapping file) the information of an EntireX client call to XML (so it can be
understood by an application with an XML interface). The RPC Server for XML/SOAP sends the
XML document to the XML-based server via HTTP(s) and receives an XML document from the
XML-based server. It translates the received XML document and sends the response to the RPC
client.

EntireX XML/SOAP Wrapper 7



Introduction to the XML/SOAP Wrapper

EntireX RPC Request
(receive by XML RPC Server)

result = myTesteale { operation , operand_1 |, operand_2 )

Il

Fi

/
XML Server generates and sends XM fDon ument
/ / /
<?xml version ="1.0" enchingf'utpe" 7>
<CALC> / /
L4

/

<Operand_1>332333332«/0perand_1>

-:Dp-erau'on‘a-vc.foparaljunh /

<Operand_2»222233222<[0perand_2>

<fCALC= j

T
e

i

XML Server receives resulting XML Document

<7xml version ="1.0" encoding="utf-8" 7=
<CALC=>
<Result=-555555555</Result>

<fCALC> . == —

e

EntireX RPC Response
(send by XML RPC Server)

result = myTesteale { operation , operand_1 |, operand_2 )

EntireX XML/SOAP Wrapper



Introduction to the XML/SOAP Wrapper

Development Environment

= XML Mapping Editor
= Generation Utilities

During the development process, users map XML document structures to RPC parameters and
vice versa, and generate the XMM (XML Mapping) File.

Designer

writes

XML Mapping Editor

The input for the XML Mapping Editor is an existing Software AG IDL file. See XML Mapping
Editor.

The XML Mapping Editor allows users to map the structure of an incoming XML document to
the incoming parameters (IN, INOUT) of a Natural RPC Server and the parameters returned by
the EntireX/Natural RPC server (OUT, INOUT) to the structure of the outgoing XML document.

To ease the development process, standard mappings can be created automatically. These can be
modified and adapted.

Supported standard mappings are:

" element-oriented mapping
" attribute-oriented mapping

® SOAP-conformant mapping

See Basic IDL-XML Mapping.

EntireX XML/SOAP Wrapper 9



Introduction to the XML/SOAP Wrapper

Generation Utilities

After the mapping process, the following runtime components can be generated:

® XML Mapping Files
are used at runtime to map between the XML documents and the EntireX/Natural RPC paramet-
ers.

XML/SOAP Runtime Environment

The EntireX XML/SOAP Runtime enables XML-based clients to communicate with an EntireX/Nat-
ural RPC Server; and it enables EntireX RPC clients to communicate with applications that have
an XML or SOAP interface (via XML/SOAP Runtime).

XML Clients Communicating with EntireX/Natural RPC Servers

The incoming XML document is mapped by the generated XMM file to the EntireX/Natural RPC
parameters, using the mapping files created during the development process. From the parameters
returned by the EntireX/Natural RPC server, the generated XMM file creates the outgoing XML
document, using the corresponding mapping files.

Clients Agent Server
Web ML
> e Document. XML/SOAP Runtime
Interface 4———
]:;a +—> . - . . B 44— Entirex — > RPC
s - )f::: E Broker % . Server

- >
Java <

The XML/SOAP Runtime provides two client-side interfaces:

® A Java interface
The Java interface can be used by Java clients. See Client Using the Java Interface.

® An HTTP interface
The HTTP interface supports HTTP Post Request and HTTP Get Request. See The HTTP Interface.

To make it possible to call the XML/SOAP Runtime from within a Web server, see Listener for
XML/SOAP.

10 EntireX XML/SOAP Wrapper



Introduction to the XML/SOAP Wrapper

EntireX Clients Communicating with XML or SOAP Interfaces

The XML/SOAP Runtime can connect EntireX clients to applications that have an XML or SOAP
interface, for example SAP or PeopleSoft. These applications are then the XML server. Example:
An EntireX client requests information of an SAP application. The request is sent to the EntireX
Broker and the EntireX XML/SOAP Runtime (translated to XML there) and then to the SAP XML
interface, processed by the SAP application. The response is returned the same way.

Clients Agent Server

Application

XML/SOAP . w)

Runtime Interface
.1—
EntireX | - B '
Client I;ntllr‘ex \
Application = 1 TLIZS = -
_ —.. S0
Files AP

T l Application

Java Interface
for XML/SOAP
RPC Server

The XML/SOAP Runtime provides two server-side interfaces:

® A Java interface
The Java interface can be used to modify the document and determine further processing.

® An HTTP interface
The XML/SOAP document is sent to the specified target.

Glossary of Terms

RPC Server for XML/SOAP
The EntireX RPC Server for XML/SOAP allows RPC clients to communicate with target servers
via HTTP(S). The RPC Server for XML/SOAP transforms RPC client calls into XML/SOAP
calls. It works together with the XML/SOAP Wrapper.

XML-based Client
Client sends and receives data as an XML or SOAP document.

XML-based Server
Server receives and sends data as an XML or SOAP document (for example a web service).

EntireX XML/SOAP Wrapper "



Introduction to the XML/SOAP Wrapper

XML Mapping File
The XML Mapping File is an XML file (file extension .xmm) generated by the EntireX XML
Mapping Editor and used by the EntireX XML/SOAP Runtime, to map between XML documents
and EntireX/Natural RPC parameters.

XML/SOAP Runtime
The EntireX XML/SOAP Runtime enables XML-based clients to communicate with an En-
tireX/Natural RPC Server; and it enables EntireX RPC clients to communicate with applications
that have an XML or SOAP interface (via XML/SOAP Runtime).

XML/SOAP Wrapper
The EntireX XML/SOAP Wrapper enables XML-based communication to EntireX/Natural RPC
servers and communication from EntireX/Natural RPC clients to XML-based servers.

12 EntireX XML/SOAP Wrapper
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Migration Considerations for XML/SOAP Components

RPC Server for XML/SOAP

Update the start script to set the paths to current installation. If the properties file contains a path
to the configuration file, you may need to adjust the path. The properties and configuration files
can be used as before. See Configuration File in the RPC Server for XML/SOAP documentation for
more information.

XML/SOAP Wrapper

Update the start script to set the paths to current installation.

Listener for XML/SOAP

The migration steps depend on the Web server you are using:

® Using the Software AG Web Server based on Apache Tomcat / Software AG Runtime from
Software AG Installation
Save your web services (AAR files) and modified configuration files (that is, axis2.xml). You do
not need to re-generate your web services (AAR files). If the configuration was modified, perform
the same modifications for the new installation and restart Software AG Web Server. Redeploy
the web services (AAR files).

Note: The new installation will use another port by default, which means that the Web

clients need to be adjusted.

® Using another Web Server
Save your web services (AAR files) and modified configuration files (that is, axis2.xml). You do
not need to re-generate your web services (AAR files). For deployment of file wsstack.war and
copying file entirex.jar to Web Services Stack, see the separate Web Services Stack documentation
in the Software AG Infrastructure Administrator's Guide under Software AG Suite & Cross-Product
Guides.

If configuration was modified, perform the same modifications for new installation and restart
the Web server. Redeploy the web services (AAR files).

14 EntireX XML/SOAP Wrapper
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Using the XML/SOAP Wrapper

Mapping IDL Parameters to XML Structures

Use the XML Mapping Editor to map IDL parameters to XML structures.
The mapping editor offers several mapping types:

® element mapping: all IDL parameters map to elements in an XML document

= attribute mapping: all scalar/simple IDL parameters map to attributes; program name and
complex types (groups and structures) map to elements

® SOAP mapping: a standard SOAP document is generated, IDL parameters map to elements in
<Body>-part

* user-defined mapping: users create their own XML or SOAP documents and map the IDL
parameters to elements or attributes of an XML document.

In addition, the mapping editor shows one of general information (Overview page), the request
message (XML Request), response message within fault information (XML Response page),
mapping parameters (Mapping Parameters page) or sample editor (XML Samples page) at one
time.

16 EntireX XML/SOAP Wrapper



Using the XML/SOAP Wrapper

2 CALCRT.ovm P CALCRTidl [mh *myidlamm 52

~ General Information

This section describes general information about this mapping:

Software AG IDL File: Ch\Deviworkspacesiruntime-EclipseApplication\CobolSource\myidl.idl

Last modification:  2018-11-14 11:00:52

XXMM Mapping File:  /CobolSource/myidlxmm

Last modification:
* Mapping Parameters
Subset of available Mapping Parameters. To get the full list, follow the Link below or choose the Mapping Parameter page directly.
Marmespace URL  urn:com-softwareag-entirex-rpe: Sal-%6p

Enable Mull Value Suppression

@n Mapping Parameters Get the full list of Mapping Parameters

Set current null value suppression setting to all mappings: | Update Mull Value Suppression

~ Mapping

Choose a mapping style for all programs and directions. Existing mappings will be overwritten!

) Element () Attribute @ 504P ) Customized
+ Testing

Launch the XML Tester to test this mapping for XML/SOAP Listener
+: Direct Test Call directly an RPC Server.
+ HTTP Test Call an RPC Server via the EntireX XML/SOAP Listener, Mote: Requires deployed AAR file,
~ Validation
Make all the available Yalidity Checks in all Programs: Element Names, Attribute Mames, validate the XML Node Properties, the XML Node Mapping, the
encoding when using unicode data types, lock for existing Namespace Prefix definitions used in xsittype attributes and inform about unmapped IDL

Parts.

v=| Validate Start the Validation

Owerview | XML Request XML Response | Mapping Parameters | XML Samples

Setting Wrapper Properties

Before you start the generation of the XMM file, select the IDL file and open the context menu to

set the properties for this IDL file. The settings for an IDL file are inherited from the preferences
(they provide the defaults):

EntireX XML/SOAP Wrapper 17



Using the XML/SOAP Wrapper

& Properties for example.idl

|tv|:|e filker kewxt

| EntireX =

Resource

Enkirew \NET “Wrapper
Enkires C Wrapper

Enkires COBOL Wrapper
Enkires Cuskam Wrapper
Enkires DCOM Wrapper
Entirex EJB Wrappet

Enkirews Java Wrapper
Entirex PLIT Wrapper

Entirex \Web Service \Wrapper
RunjDebug Settings

General Entirel IDL properties ko specify the Broker ID and the Service Description
(Class, Server, Service) that are used in the various Entirer Wrappers, The default
settings are provided by the Entirel preference page.

Broker ID: | localhost: 1971 |
Server Class: | RPiC |
Server Mame: | SRV |
Service: | CALLNAT |

[ Restare Defaults ] [ Apply ]

[ Ok H Cancel ]

~ To set the general options, path settings and XML options

1
2
3
4

5

Select Preferences... in the Windows menu of Eclipse.

Select Software AG > EntireX.

Select the tab XML.

Fill in the screen as follows:

Screen Item

Description

XML default encoding

This encoding is used for the XML/SOAP document sent, if the box “Use
incoming encoding” is not checked (for XML-based clients) or if the RPC
Server for XML/SOAP is used.

Use incoming encoding

Check this box to enable the XML/SOAP Wrapper to use same encoding for
the incoming document as for the outgoing document.

Confirm the settings with OK.

After setting the general properties, set the properties specific to the IDL file. The settings for the
XML/SOAP Wrapper classes are on the two tab pages: General and XML.

1

To set the IDL properties

In the file tree browser, select the IDL file to be processed.

18
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Using the XML/SOAP Wrapper

2 To display the Properties window, use either the context menu or the File menu and choose
Properties.
The subsequent screen will show the defaults you entered with Tools > Options..

3 Use this page to specify the Broker ID, the server address (Server class, Server name, and
Service) and other properties. If you do not enter Broker ID, server name, etc., the defaults
(as entered in the Tools / Options menu) will be used.

4  Select the XML tab.

5 Complete the screen as follows:

Screen ltem Description

XML default encoding |This encoding is used for the XML/SOAP document sent, if the box “Use
incoming encoding” is not checked (for XML-based Clients) or if the RPC
Server for XML/SOAP is used.

Use incoming encoding |Check this box to enable the XML/SOAP Wrapper to use the same encoding
for the incoming document as that used for the document sent.

6  Confirm the settings with OK.

Generating an XMM File

To generate the XMM file, use the Designer.

The IDL file, the XML file and the properties are used to generate an XMM file.

~ To generate the XMM file
1 Specify an IDL-XML mapping.
2 Save the mapping.

If you are using the default settings of the Software AG Designer, an XMM file is saved. The name
of the XMM file is <idl file name>xmm

@ Caution: If you modify the IDL file, the IDL-XML mapping file or the properties, you must
re-generate the XMM file.
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Default Values Used by the XML/SOAP Runtime

The XML/SOAP Runtime uses standard default values for all parameters (for EntireX RPC) and
elements/attributes (for XML documents) if no value can be retrieved and no user default value
is defined. The table below shows the standard default values for XML and RPC.

Value | Description

A(n) | XML|Empty string with length 0.
RPC |String with n blanks.

AV Empty string with length 0.
B(n) String with n zeros.
BV Empty field with length 0.

K(n)|XML |Empty string with length 0.
RPC |String with n blanks.

KV Empty string with length 0.
L false

I1 0

12 0

14 0

Fa 0.0

F8 0.0

N 0.0

P 0.0

D new Date()
T new Date()

U(n) | XML |Empty Unicode string with length 0.
RPC |Unicode String with n blanks.

UV | XML |Empty Unicode string with length 0.
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5 RPC Environment Manager for RPC Server for XML/SOAP

The RPC environment for RPC Server for XML/SOAP is managed on the Preferences page.
Use the RPC Environment Monitor to check the availability of each RPC environment.

Using this wizard, you can add new RPC environments for RPC Server for XML/SOAP. To manage
these RPC environments, open the Preferences page.

T W T
& Preferences ———— C=_REL

type filter text RPC Environments for RPC Server for XML/SOAP L= -
4 Software AG -

[» Ajax Developer
API-Portal Table of defined RPC environments:

i Business Services MName : Broker ID Server Address Insert...

[» Code Generation
b Construct KMUSOAP RPC Server  localhost:1971 RPC/XMLSERVER/CALLMAT
>

Document Expansio — ;

4 EntireX Duplicate
[ COBOL L
Integration Serve 1

Manage the RPC Environments for RPC Server for XML/SOAP,

Edit...

Remaove

= Matural

[ PLI

4 Web Services
| RPC Environt
Web Service’
XML Mappin

[» Wrappers s

4 I I

@ ® [ ok [ cance |

| Note: A predefined RPC environment is provided for the default RPC Server for XML/SOAP.

This RPC environment cannot be removed.
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~ To edit an existing RPC environment

m  Select the table row and press Edit.... If multiple entries are selected, the first entry is used.

> To remove an RPC environment

m  Slect the table row and press Remove. You can select multiple environments.

> To create a new RPC environment

1 Choose Insert... to call the following screen:
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= RPC Environments |. SRNC X

New RPC Environment for RPC Server for XML/SOAP

Define a new RPC Environment.

Broker Parameters

Broker ID: illiocalhost:1971

Server Address: RPC/SRVL/CALLNAT

Timeout (5econds): G0

EntireX Authentication RPC Server Authentication
User ID:

Password:

Extractor Settings

Wrapper Settings
@ Save locally

Save remotely

Envircnment Mame
(71 Default

@ Other:  XML/SOAP RPC Server (2)

@' < Back [ Mext > I [ Finish ] [ Cancel

2 Enter the required fields: Broker ID, Server Address and a unique Environment Name, which
will have the default format brokerID@serverAddress. The given Timeout value must be in the
range from 1 to 9999 seconds (default: 60).

EntireX Authentication describes the settings for the broker, and RPC Server Authentication
describes the settings for the RPC server.
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6 RPC Environment Monitor

The RPC Environment Monitor is part of the Software AG Designer. It is an Eclipse view that
provides a quick overview of the availability of the defined RPC environments in your workspace.

~ To open the RPC Environment Monitor from the EntireX perspective

s Choose Window > Show View > RPC Environment Monitor.

~ To open the RPC Environment Monitor from a non-EntireX perspective

s Choose Window > Show View > Other > Software AG > RPC Environment Monitor.

The RPC environments are managed on the Preferences page. See RPC Environment Manager
for RPC Server for XMLL/SOAP.

RPiC Enwiranment Monitar &2 2]

Table of defined RPC environments:

MName Broker ID Server Address Skatus
7 Java RPC Server @ localhost: 1971 @ RPC/SRY1JCALLMNAT Broker Error 0007 0007; RPC/SRYLMCALLMAT not registered
-_'3” Matural RPC Server @ localhost: 1971 B RPC/MATSRWZEO0MCALLMAT - Matural RPC Server 6.3.4.4 on WHNT-2386 (NATAS11.0)
E’ﬂ #MLISCAP RPC Server B localhost: 1971 @ RPOSRMUSERVER/CALLMAT  Enkired #ML RPC Server 8.2.2.0,162 Windows 2P 5.1 %86,

The status check starts when the view is opened. To force an additional check, choose Refresh
from the Views toolbar. The status check can be cancelled in the dialog that appears or within the
Eclipse progress view. When the check is complete or if it cancelled, the following symbols indicate
the status of the corresponding item. The table will be reloaded every time a status check is started
to make sure all stored RPC environments are available.

25



26

RPC Environment Monitor

Symbol | Status

| Running.

@ Not running.

o Unknown (at the beginning of the check or if the check was cancelled).
]

Note: Additional status information (including error messages) is displayed when refreshing

the view (by a ping command to all specified RPC servers).
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Introduction to the EntireX XML Tester

Using the EntireX XML Tester you can send an XML document to the EntireX Listener for
XML/SOAP.

The EntireX XML Tester supports drag-and-drop editing, and you can restore the last used session
within a workspace. If the mapping file has changed, the views for request and response are
cleared.

The EntireX XML Tester is provided by the Designer as an Eclipse View and can be opened from
the XML Mapping Editor or XML/SOAP Wrapper. It is also accessible from Windows > Show
View > Other... > Software AG > XML Tester. The following test modes are available:

® Direct Test (Using the Java Interface)
= HTTP Test (Using the EntireX Listener for XML/SOAP)

See sample screen and description of options below.

= Tasks KMLTester bcs RPC Envirenment Menitor Entire}(DefauIthker B 1s = O

= Target and Environment Area

@ HTTP Test (XML/SOAP Listener) HTTP URL  http://localhost10010/ wsstack/services -
©) Direct Test XMM or AAR File: -
Input XML Document:
Document Area (Request and Response) [l":7l-I
Tree View | Text View | Raw View
<%ml version="1.0" encoding="UTF-8" 7> -

<!-- Generated by Software AG, EntireX XML Mapping Editor (10.5.0.0) on 2018-11-21 at 08:22:53 --»
<m:CALC xmins:m="urn:com-softwareag-entirex-rpc EXAMPLE-CALC" =
<Operation>+</Operation>
<Operandl > 21 </Operandl »
<Operand2>6</0perand2>
</miCALC> B

m

1

4 P

Tree View | Text View | Raw View

28 EntireX XML/SOAP Wrapper



EntireX XML Tester

EntireX XML Tester Options

= Table of Values

= Direct Test Details Dialog

= EntireX/HTTP/HTTPS Parameters Dialog
= Add Parameter Dialog
= Edit Parameter Dialog

Table of Values

Name

Type

Description

Direct Test

Check box

Check this box to test the Java interface of the XML/SOAP Runtime.
If checked, the Settings action will open the Direct Test Details
dialog.

XMM or AAR File

Text field

The AAR file, which contains one or more mapping files (XMM files),
or the XMM file, which contains the mapping information. Accept
absolute path.

If the file does not exist, the action Create Sample XML... is disabled.
When the file is found, the Broker ID and Server Address are read
and the corresponding fields in the Direct Test Details dialog are
filled.

If a corresponding WSDL file within a definition of EntireX parameters
is found, the EntireX parameters are added to the EntireX parameters
setting and the URI is set.

Combo box

Behavior depends on content of field XMM or AAR File:

= If this field contains an AAR file, this combo is enabled and filled
with all the mappings stored in the archive. Select the mapping
you want from the list.

= If this field contains an XMM file, the combo box is disabled.

Browse...

Button

Open a File open dialog to select the XMM or AAR file from the file
system.

HTTP Test

Check box

Check this box to test the HTTP interface (EntireX Listener for
XML/SOAP) of the XML/SOAP Runtime. If checked, the Settings
action will open the EntireX’HTTP/HTTPS Parameters dialog.

HTTP URI to
contact

Combo box

URI of the EntireX Listener for XML/SOAP. Will store the last ten
called URLs.

Input XML
Document to send

Text field

File name of the XML Document to be sent.

Browse...

Button

Open a File open dialog to select the XML Document file from the
file system.

EntireX XML/SOAP Wrapper
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Name Type Description
Create Sample Action B Open the Create Sample XML... dialog, see below. If the text file for
XML... the XMM file does not contain a valid file path, the Create Sample
XML... button is disabled.
input - area Tree/Text/Raw Input field for the XML data to be sent to the Broker, this area is filled
view with the text/tree representation of the selected file, see Input XML
Document to send. If empty, the Play action is disabled.
output - area Tree/Text/Raw  |Output field for the XML data response from the Broker. By default,
view the response will be displayed in platform encoding. But if the XML
data request contains a valid encoding in the XML declaration, this
encoding will be used and a tooltip text will inform you of this. This
view will also display the status and errors.
Settings Action E Open either Direct Test Details or EntireX/HTTP/HTTPS Parameters
dialog. See Direct Test and HTTP Test above.
Play/Stop Action  / H Start/stop the test. This action is disabled if there is no text in the
input - area.
Reset Action 1@ Reset the input and output areas.

Direct Test Details Dialog

Use the Direct Test Details dialog to change the Direct Test parameters. The Broker ID, Server
Address, the Security Settings, the Natural Settings can be modified for this EntireX XML Tester
session. Compression Level is a non-editable box that contains all possible values. Broker ID and
Server Address are editable dialog boxes and hold the last five used values. Use the Reliable RPC
check box to turn reliable messaging on or off (mode is AUTO-COMMIT). See Reliable RPC.

= XML Tester

==

Direct Test Details
Define Direct Test parameters.

Main | Broker Securityl Naturall

Broker ID: localhost:1971

Server Address:

RPC/SRV1/CALLMNAT

Compression Level:

[T Use Codepage

I [ Reliable RPC (auto-commit)

OK ] ’ Cancel

30
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EntireX/HTTP/HTTPS Parameters Dialog

This dialog contains the following tabs:

= EntireX Parameters
= HTTP Headers
= HTTPS Parameters

EntireX Parameters

With the EntireX Parameters tab you can add more EntireX-related information for the call. An
entry must be selected to be active. The Value box holds the last five used values or the predefined
values for the corresponding property. It is editable, which means you can change a value by
clicking directly in the table. EntireX parameters can be added to the request XML/SOAP document
(default) or as HTTP header entries.

& XML Tester 4

EntireX/HTTP/HTTPS Parameters E
Manage EntireX/HTTP/HTTPS Parameters

EntireX Parameters HTTP Headers HTTPS Parameters

Key Value Add...
exx-brokerlD localhost: 1971 Edit
exxK-service RPC/SRV1/CALLNAT
Remove
Select A
Deselect All

Add EntireX Parameters to
® SOAP/ XML Reguest Document (O HTTP Header

oK Cancel
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HTTP Headers

With the HTTP Headers tab you can add more information for the call and set the SOAPAction.
An entry must be selected to be active. The Value box holds the last five used values for the cor-
responding property. It is editable, which means you can change a value by clicking directly in
the table.

& XML Tester >
EntireX/HTTP/HTTPS Parameters
Manage EntireX/HTTP/HTTPS Parameters
EntireX Parameters HTTP Headers HTTPS Parameters
Key Value Add...
SOAPAction CALC :
Edit...
Remove
Select Al
Deselect All
OK Cancel
HTTPS Parameters

With the HTTPS Parameters tab you can set parameters required for an HTTPS connection. An
entry must be selected to be active. The Value box holds the last five used values or the predefined
values for the corresponding property. It is editable, which means you can change a value by
clicking directly in the table.
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£ XML Tester *

EntireX/HTTP/HTTPS Parameters E
Manage EntireX/HTTP/HTTPS Parameters

EntireX Parameters HTTP Headers HTTPS Parameters

Key Value Add...
javaxnetssl trustStore Cpathtomuststors .
V] javaxnetssltrustStorePassword  [fUStStoreibasswermm =
Remove
Select All
leselect A
0K Cancel

Add Parameter Dialog

With the Add dialog you can add a new EntireX, HTTP or HTTPS parameter. All Software AG's
predefined parameters are listed in the Key box. A validation runs on the value of a predefined
parameter.

Edit Parameter Dialog
With the Edit dialog you can change the value of a property. The Value box is editable and holds

the last five used values. The Key value for all predefined properties cannot be modified. A valid-
ation runs on the value of a predefined parameter.

EntireX XML/SOAP Wrapper 33



EntireX XML Tester

S XML Tester X

Add new EntireX Parameter E

Define key and value for the EntireX Parameter.

Key:
Value: | RPC/SRV1/CALLNAT ‘

'f?:' OK Cancel

exx-service w

Using the EntireX XML Tester

Using the EntireX XML Tester you can send an XML document to the EntireX Listener for
XML/SOAP.

~ To open the EntireX XML Tester

In perspectives other than EntireX, choose Window > Show View > EntireX XML Tester, in
other perspectives, choose Window > Show View > Other ... > Software AG > XML Tester.

Or:

Choose Window > Open Perspective > Other... and select EntireX Perspective. The EntireX
XML Tester view is part of this perspective.

Or:

In the XML Mapping Editor, switch to the Overview page, choose Direct Test or HTTP Test
in the testing section.

Or:

In the XML Mapping Editor, switch to page XML Samples, select one document, choose En-
tireX XML Tester in the context menu.

34

EntireX XML/SOAP Wrapper



EntireX XML Tester

> Torun a test

1  Load the mapping information. In field XMM or AAR File, enter the absolute path to the
AAR or XMM file that is being tested (you can use the Browse... button or a drag-and-drop
operation). If you enter an AAR file, all mappings contained in the archive are listed in the
combo box next to the XMM or AAR File field.

@ HTTP Test (XML/SOAP Listener) HTTP URL  http://localhost10010/ wsstack/services -
) Direct Test HMM or AAR File:  D:vworkspaceimoreXmm.aar -- lnamawcmm "] | Browse... |
names.xmm
Input XML Document: g
countries.xmm 4

2 Select the testing interface (Java or HTTP):

= Java interface: the XMM or AAR File field must contain the full path and name of an XMM
or AAR archive. Choose the Direct Test option to use this interface.

® HTTP interface: enter the name of the URI of the running EntireX Listener for XML/SOAP.
Choose the HTTP Test option to use this interface.

3 Complete the input area:

* Type your XML document.
= Use the Create Sample XML... button and follow the dialog.

| Note: If the IDL file contains only one library with one program, this is used for the
sample generation without opening the dialog.

Example dialog;:
= XML Sample Generaticn I. EY ﬁl
Select a program from the corresponding library.
a 4 EXAMPLE
&7 CALC
&P SQUARE
(?:' [ oK ] ’ Cancel

* Load sample document, using drag-and-drop operation on the sample page of XML Mapping
Editor or file browser.
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e examplexmm 52 = B 5= Outline 2 e = ¥ = 8
4 4 EXAMPLE
XML Sample Documents =) 4 4P CALC
DL 5] XML Documents 0 " Operation (A1) In
4" Operandl () In
Fl @" EXAMPLE <%xml version="1.0" En-:c::lin:J:"'JT.F—.S".?'» ) B QP Operand2 (M) In
a P CaLC =<!-- Generated by Software AG, EntireX XML Mapping Editd 4P Function_Result (4) RESULT
= Request Document| =miCALC xminsim="urn:com-softwareag-entirex-rpaEXA. -
= 9 ~a < Operation>+</Operation> 4 @p SQUARE
|=| Response Document <Operandl >21</Operandl> 4 Operand (4) In
4 4P SQUARE \\ < Operand2>6+</0perand2> 4" Result (1) Qut
|=| Request Document e /i CALC:
\
|= Response Document \ I
[lp T EI
Overview | XML Request | XML Response | Mapping Parameters | XML Samples
\
\
Tasks )(MLTesterSZ RPC Environment |r. | = 8
\
~ Target and Environment Area 'InI it
@ HTTP Test (XML/SOAP Listener) HTTP URL '.http:_a'_a'localh05t:10010_a’w55tack.-'ser\rices -
1
() Direct Test AMM or AAR File: :DI\WDVkSPECE\aEmNE-Xmm -- -ﬁrowse...
!
r
Input XML Document: Browse...
Document Area (Request and Response) / [l;
’
Tree View | Text View | Raw View ;!
A

Requesk Document
4

Tree View | Text View | Raw View

The following tabs are available:

® The Text View tab will try to color the request syntactically, making the XML easier to
read.

® The Raw View tab is initially empty. When the first request is sent, it is filled with the

exact message sent together with information on the request method and the used HTTP
headers with their values.

® From then on the Raw View is displayed and is updated with the last sent request.

Select an existing XML document (you can use the Browse button) and enter it in the field
Input XML file to send.

If the testing interface is Java, the Settings action will open the Direct Test Details dialog.
The dialog contains the three tabs with the following settings:

" Main

® Broker Security

* Natural Security
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See Direct Test Details Dialog.
5 Ifusing option HTTP Test, the Settings action will open the EntireX’HTTP/HTTPS Parameters
dialog. The dialog contains three tabs with settings for the HTTP call:
" EntireX Parameters
= HTTP Headers
® HTTPS Parameters

See EntireX/HTTP/HTTPS Parameters Dialog.

6  Send the request by choosing action Play. If the testing interface is HT'TP, the Sending request
dialog appears. Here you have several options:

® hide the dialog by pressing Run in Background button
® cancel the request. This will terminate the session with the server

® show details about all running Eclipse jobs

A progress bar on the Eclipse status bar shows to indicate that the request is being sent.

| Tasks XML Tester &3 RPC Environment Monitor EntireX Default Broker (] g-| = O

+ Target and Environment Area

@ HTTP Test (XML/SOAP Listener) HTTP URL  http://localhost10010/wsstack/services -

() Direct Test XMM or AAR File:  Di\workspace\examplexmm --
Input XML Decument:
Ik

r

Document Area (Request and Response)
Tree View | Text View | Raw View

<%l version="1.0" encoding="UTF-8" 7=
<l-- Generated by Software AG, EntireX XML Mapping Editor (10.5.0.0) on 2018-11-21 at 08:22:53
<m:CALC xminsim="urn:com-softwareag-entirex-rpc EXAMPLE-CALC" =
< (Operation>+</Operation>
<QOperandl»21</0perandl >
<(Operand2>6+</Operand2>
</m:CALC=

4

Tree View | Text View | Raw View

"Processing .."

: EXMLTester. Sending request... [r— ]

If you used the Direct Test option, you cannot cancel the request.
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7 When a response is received, it is displayed in the output area. Errors are also displayed in
the output area.

The Text View tab displays the XML response as formatted and syntactically colored text.
The Raw View tab displays the response “as is”. Information on the used request method,
response code and HTTP headers with their values is displayed for the XML response.

Using the Broker and RPC User ID/Password

EntireX supports two user ID/password pairs: a broker user ID/password pair and an (optional)
RPC user ID/password pair sent from RPC clients to RPC servers. With EntireX Security, the broker
user ID/password pair can be checked for authentication and authorization.

The RPC user ID/password pair is designed to be used by the receiving RPC server. This compon-
ent's configuration determines whether the pair is considered or not. Useful scenarios are:

® Credentials for Natural Security

® Impersonation in the respective RPC Server documentation

" Web Service Transport Security with the RPC Server for XML/SOAP, see XML Mapping Files

" Service execution with client credentials for EntireX Adapter Listeners, see Configuring Listeners
" etc.

Sending the RPC user ID/password pair needs to be explicitly enabled by the RPC client. If it is

enabled but no RPC user ID/password pair is provided, the broker user ID/password pair is inher-
ited to the RPC user ID/password pair.

The check box Enable Natural Logon (see below) enables sending the RPC user ID/password pair
in Direct Test mode. In HTTP test mode, the HTTP parameter exx-natural-security has to be set.
If you do so, we strongly recommend using SSL/TLS. See SSL/TLS, HTTP(S), and Certificates with
EntireX.

~ To use the broker and RPC user ID/password with Direct Test mode

1  Specify a broker user ID and broker user password in the Broker Security tab.

2 Activate the Natural tab and check the check box Enable Natural Logon to enable sending
the RPC user ID/password pair.

3  If different user IDs and/or passwords are used for broker and RPC, enter RPC User 1D and
RPC User Password in the Natural tab to provide a different RPC user ID/password pair.

4 By default the library name sent to the RPC server is retrieved from the IDL file (see
Tibrary-definitionunder Software AG IDL Grammar in the IDL Editor documentation). The
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library name can be overwritten. This is useful if communicating with a Natural RPC server.
Specify a Natural library in the Natural tab.

~ To use the broker and RPC user ID/password with HTTP Test mode

1  Activate the EntireX tab.
2 Add exx-user and exx-password as EntireX parameters.

3  Add EntireX parameter exx-natural-security to enable sending the RPC user ID/password
pair.

4  If different user IDs and/or passwords are used for broker and RPC, add exx-rpc-user and
exx-rpc-password as EntireX parameters to provide a different RPC user ID/password pair.

5 By default the library name sent to the RPC server is retrieved from the IDL file (see
Tibrary-definitionunder Software AG IDL Grammar in the IDL Editor documentation). The
library name can be overwritten. This is useful if communicating with a Natural RPC server.
Specify a Natural library in HTTP parameter exx-natural-Tibrary.

Using Conversational RPC

> To use conversational RPC with HTTP Test mode

1 Open Settings.
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& XKML Tester *
EntireX/HTTP/HTTPS Parameters
Manage EntireX/HTTP/HTTPS Parameters
EntireX Parameters HTTP Headers HTTPS Parameters
Key Value Add...
Edit...
Remove
Select All
Deselect All
Add EntireX Parameters to
SOAP/XML Request Document HTTP Header
0K Cancel
2 Add key exx-conv and set value to "OPEN".
£ XML Tester X
Add new EntireX Parameter
Define key and value for the EntireX Parameter.
Key: | exx-conv ot
Value: | [0y}
@ 0K Cancel
3  Press OK.
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& XKML Tester

EntireX/HTTP/HTTPS Parameters
Manage EntireX/HTTP/HTTPS Parameters

EntireX Parameters HTTP Headers HTTPS Parameters

Key Value Add...
L] exx-conv OPEN :
Edit...
Remove
Select All
Deselect All
Add EntireX Parameters to
SOAP/XML Request Document HTTP Header
0K Cancel
4  Select exx-conv.
S XML Tester
EntireX/HTTP/HTTPS Parameters
Manage EntireX/HTTP/HTTPS Parameters
EntireX Parameters HTTP Headers HTTPS Parameters
Key Value Add...
eXx-conv OPEN )
Edit...
Remove
Select All
Deselect All
Add EntireX Parameters to
® SOAP/XML Request Document (O HTTP Header
0K Cancel

EntireX XML/SOAP Wrapper
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5 Press OK.

6  Send the request.

7  The response contains the exx-xml-sessionlID used for conversational communication. This
parameter is also added to EntireX parameters for the next call(s) automatically. The parameter
exx-conv is deactivated simultaneously.

8§ <!-- snippet with exx-xml-sessionID in response document -->

<axis2nsl:EntireX xmlns:axisZ2nsl="urn:com.softwareag.entirex.xml.rt">
<{exx-xml-sessionID>XML610C044029044C05</exx-xml-sessionID>
{/axis2Znsl:EntireX>
<I-- snippet -->

9  To finish the conversation, open the settings again, activate the exx-conv and set its value to
"COMMIT" or "BACKOUT".

10 The conversation is closed with the next sent call.
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Using the XML/SOAP Wrapper in Command-line Mode

Command-line Options

See Using EntireX in the Designer Command-line Mode for the general command-line syntax. The
table below shows the command-line options for the XML/SOAP Wrapper.

Task Command Option Description

Create SOAP-conformant XML -map:soap

mapping for all programs. -map:soapl.l Supported for compatibility
with older versions.

Create attribute-preferred XML -map:xmlattributes

mapping for all programs.

Create element-preferred XML -map:xmlelements

mapping for all programs.

Create element-preferred XML -map:xmlwithxsd -namespace|If namespace is specified, the

mapping with XML Schema for all namespace URI for the

programs program node. XML Schema

uses this namespace URI as the
target namespace.

Create sample XML documents for |-xml:sample
all programs.

Example

<workbench> -map:soap /Demo/example.id]l

where <workbench> is a placeholder for the actual EntireX design-time starter as described under
Using EntireX in the Designer Command-line Mode.

The name of the IDL file includes the project name. In the example, the project Demo is used. If
the IDL file name describes a file inside the Eclipse workspace, the name is case-sensitive.

If the first part of the IDL file name is not a project name in the current workspace, the IDL file
name is used as a relative (based on the IDL file) or absolute file name in the file system. Thus, the
IDL files do not need to be part of an Eclipse project.

Status and processing messages are written to standard output (stdout), which is normally set to
the executing shell window.
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Further Examples

Windows Example 1

<workbench> -map:soap C:\Temp\example.id]

Uses the IDL file C:\ Temp \ example.idl and generates the XML mapping file example.xmm in parallel
to the IDL. Slashes and backslashes are permitted in the file name. Output to standard output:

Using workspace file: C:\myWorkspace\.
Processing IDL file: C:\Temp\example.idl
Store XML mapping file: C:\Temp\example.xmm
Exit value: 0

Windows Example 2

<workbench> -map:soap /Demo/example.id]l

Generates XML mapping files for all IDL files in project /Demo.
Linux Example 1

<workbench> -map:soap /Demo/example.id]

If the project Demo exists in the workspace and example.idl exists in this project, this file is used.
Otherwise, /Demol/example.idl is used from file system.

Linux Example 2

<workbench> -map:soap /Demo/example.id]

Generates XML mapping files for all IDL files in project Demo (or in folder /Demo if the project
does not exist).
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9 Tracing the XML/SOAP Runtime

See Tracing the XML/SOAP Runtime Linux | Windows.
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Connecting between XML-based Clients and an EntireX RPC Server

Entirex KML-
B Gl
Server
Entirex Entirex
RPC . XMLISOAP x""élw
Server Iw

Publish an Existing EntireX RPC Server for XML-based Clients

You have an existing EntireX RPC server and want to extend its availability to XML-based clients
(e.g. offer the functionality of your server as a web service). The simplest approach is to use the
EntireX XML/SOAP Wrapper to convert your XML documents to EntireX RPCs and vice versa.
Then the XML-based client will appear to communicate with an XML-based server.

See Writing Applications - Connect an Existing EntireX RPC Server with an XML-based Client.
Use your XML-based Client and Connect to an EntireX RPC Server

You have an XML-based client that is to communicate with an EntireX RPC server or access a
component accessible via an EntireX RPC server. The simplest approach is to use the EntireX
XML/SOAP Wrapper to convert your XML documents to EntireX RPCs and vice versa. Then an
XML-based client will appear to communicate with an XML-based server (your EntireX RPC
server).

See Writing Applications - Build an EntireX RPC Server and Use an Existing XML-based Client
with It.
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Connecting EntireX Clients and XML-based Server

Involve an XML-based Server in your EntireX Application

You know or have written XML-based servers (e.g. web services) and want to involve them in
your EntireX application. The simplest approach is to use the EntireX RPC Server for XML/SOAP
to convert your EntireX RPCs to XML documents and vice versa; the EntireX RPC Server for
XML/SOAP handles the HTTP communication.

See Writing Applications - Build an EntireX RPC Client and Use an Existing XML-based Server.

Connect your RPC Client and the XML-based Server

You have an EntireX RPC client and want to implement your server application as an XML-based
server and you want the EntireX RPC client to use this XML-based server. The simplest approach
is to use the EntireX RPC Server for XML/SOAP to convert your EntireX RPCs to XML documents
and vice versa; the EntireX RPC Server for XML/SOAP will handle the HTTP communication.

See Writing Applications - Connect an Existing EntireX RPC Client to an XML-based Server.
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See also Generating a Web Service with HTTP Basic Authentication and Usernameloken Authentication
for EntireX Authentication under Using the EntireX Web Services Wrapper.

Listener for XML/SOAP

With the Listener for XML/SOAP you can define parameters inside the payload of a message. We
recommend this approach rather than HTTP parameters. Define the setting in the SOAP header
and under the first tag of XML document as follows:

SOAP Documents

<{soap-env:Header>
<exx:EntireX xmlns:exx="urn:com.softwareag.entirex.xml.rt">
<!-tags with parameter setting e.g: -->
<exx-natural-Tibrary>libraryname</exx-natural-library>
<exx-natural-security>true</exx-natural-security>
<{/exx:EntireX>

<{/soap-env:Header>

XML Documents

<{root-tag>
<exx:EntireX xmlns:exx="urn:com.softwareag.entirex.xml.rt">
<!-tags with parameter setting e.g: -->
<exx-natural-Tibrary>libraryname</exx-natural-library>
<{exx-natural-security>true</exx-natural-security>
{/exx:EntireX>

</root-tag>
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Using Conversational RPC

It is assumed that you are familiar with the concepts of conversational and non-conversational
RPC. See also Conversational RPC under Common Features of Wrappers and RPC-based Components
in the RPC Programming documentation.

For conversational RPC you need an instantiated conversation object. See Conversation. Conver-
sational RPC is enabled by passing a reference to this object to the method setConversation. See
setConversation. Different stubs can participate in the same conversation if they use the same
instance of a Conversation object. An RPC conversation is terminated by calling either the
closeConversation method or the closeConversationCommit method for one stub.

XML/SOAP Wrapper (Java API)

> To enable conversational RPC

= Create a Conversation object and set this with setConversation on the wrapper object.

Different wrapper objects can participate in the same conversation if they use the same instance
of a conversation object.

> To abort a conversational RPC communication

m Call the closeConversation method.

> To close and commit a conversational RPC communication
m Callthe closeConversationCommit method.

Listener for XML/SOAP

Conversations can only be used in connection with sessions. If the session is interrupted, the
conversation will be deleted.

> To use conversational RPC

m  Use the parameter exx-conv with the value OPEN.

> To continue conversational RPC

»  Pick up the parameter exx-sessionID in response and set the parameter as HTTP parameter
or in the same way as in the response document inside the request document.
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> To abort a conversational RPC communication

m  Use the parameter exx-conv with the value BACKOUT.

> To close and commit a conversational RPC communication

m  Use the parameter exx-conv with the value COMMIT.
See also EntireX XML Tester for Conversational RPC.

@ Caution: Natural RPC Servers and EntireX RPC Servers behave differently when ending an
RPC conversation.

See also Conversational RPC under Common Features of Wrappers and RPC-based Components in the
RPC Programming documentation.

Using Compression

Java-based EntireX applications (including applications using classes generated by the Java
Wrapper) may compress the messages sent to and received from the broker. There is a general
way to enable compression using broker ID, and another way that depends on whether you use
the XML/SOAP Wrapper or the Listener for XML/SOAP.

= Using Broker ID
= Using setCompressionLevel()
= Listener for XML/SOAP

Using Broker ID
You may append the keyword compresslevel with one of the values below to the Broker ID.

Examples

® localhost:1971?compresslevel=BEST_COMPRESSION

* localhost?poolsize=4&compresslevel=9

Both examples set the compression level to 9.
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Using setCompressionLevel()

Set the compression level with the method setCompressionlLevel () as an integer or a string argu-
ment.

You can use the constants defined in class java.util.zip.Deflater.
If the string

" starts with Y, compression is switched on with level 6,

= starts with N, compression is switched off (level 0).

Permitted values are the integers 0 - 9 and the corresponding strings:

BEST_COMPRESSION level 9
BEST_SPEED level 1
DEFAULT_COMPRESSION|level 6
DEFLATED level 8
NO_COMPRESSION level 0
Listener for XML/SOAP

~ To set the compression level

m  Use the parameter exx-compressLevel. The values are described in the section above.
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HTTP Proxy Settings

If the target server of your web service has to be reached through a firewall, set and adjust to your

needs the following properties:

" -Dhttp.proxySet=true

" -Dhttps.proxySet=true

® -Dhttp.proxyHost=httpprox.mydomain.org
® -Dhttps.proxyHost=sslprox.mydomain.org
" -Dhttp.proxyPort=8080

" -Dhttps.proxyPort=443

" -Dhttp.nonProxyHosts=*mydomain.org|localhost

" -Dhttp.proxyUser

" -Dhttps.proxyUser

" -Dhttp.proxyPassword
" -Dhttps.proxyPassword

Add the proxy settings to the start script.

HTTP Basic Authentication

Basic authentication is used for a target server if the attribute basicAuthentication is defined in
the TargetServer block. Basic authentication is used for all calls associated with the defined XMM

files for the <TargetServer>.

Basic authentication can be used with fixed credentials or credentials set from the RPC client ap-

plication:

= If <TargetServer> contains attributes user and password, these settings are used for basic au-

thentication.

® Otherwise the RPC client application must provide the credentials:

® For how to send the RPC user ID/password pair from an RPC client, see Using the Broker and
RPC User ID/Password (NET Wrapper | Java Wrapper | C Wrapper | PL/I Wrapper | DCOM
Wrapper | Web Services Wrapper | IDL Tester | Listener for XML/SOAP | Listener for IBM

MQ).

® For the COBOL Wrapper, refer to Using Broker Logon and Logoff and Using RPC Authentication

(Natural Security, Impersonation, Integration Server).
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® For non-RPC clients, see Using the Broker and RPC User ID/Password under EntireX XML

Tester.

See also Generating a Web Service with HTTP Basic Authentication and Usernameloken Authentication
for EntireX Authentication under Using the EntireX Web Services Wrapper.

Using SSL/TLS with the RPC Server for XML/SOAP

~ To configure SSL/TLS to a target server

1

Using HTTPS to the target server requires setting Java SSL/TLS properties and changing the
protocol of the target server's web service in the configuration file (see Configuration File).

If the web service has to be called via HTTPS (SSL/TLS), the SSL client (here the XML/SOAP
Wrapper) needs the correct certificate for the web service in the truststore to be able to com-
municate via SSL. The certificate can either be stored in the default truststore of the JVM or
in the truststore specified with the following Java properties:

-Djavax.net.ssl.trustStore=path_to_used_truststore

If truststore access requires a password:

-Djavax.net.ssl.trustStorePassword=thelruststorePassword

The SSL parameters must be included in quotes, for example

set SSL="-Djavax.net.ssl.trustStore=C:\myTrustStore.pl2 «
-Djavax.net.ssl.trustStorePassword=myTruststorePassword"

| Note: This is only an example. You must provide a truststore that matches your envir-

onment.

The truststore keeps the trusted certificate of the web service host or the certificate of its
signing (issuing) certificate authority. In the event of an SSL error, you can use the Java
property -Djavax.net.debug=all to get more information. Add the SSL parameter to the
start script of the XML/SOAP Wrapper and ensure it is passed to the start or Java. Example:
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set SSL="-Djavax.net.ssl.trustStore=C:\myTrustStore.pl2 <
-Djavax.net.ssl.trustStorePassword=myTruststorePassword -Djavax.net.debug=all"

"%JAVA_HOME_BIN%java" %PROXY% %SSL% -classpath "%CLASSPATH%" <
com.softwareag.entirex.xml.rt.XMLRPCServer -p "%ZEXXPROP%" -c "%EXXCONF%" %*

There are additional Java properties, which are usually not needed. These are described in
the Java documentation.

2 Optional. If you are using an HTTPS target server's web service address located outside the
firewall, set the following Java properties:
" https.proxyHost
" https.proxyPort
" http.nonProxyHosts
" https.proxyUser
" https.proxyPassword
3  Change the protocol of the target server's web service address from http to https in the
configuration file. Specify the fully qualified host name as TargetServer. The host name has
to match the CN (Common Name) item of the host certificate. See also configuration file (see
Configuration File). Example:
<?xml version="1.0" encoding="is0-8859-1" ?>
<EntireX
xmins="http://namespaces.softwareag.com/entirex/xml/runtime/configuration" <
version="10.9"
>
<XmlRuntime Version="1">
<TargetServer name="https://targethost:8080/entirex/xmlrt">
<xmms >
<exx-xmm name="yourFilel.xmm" />
<exx-xmm name="yourFile2.xmm" />
</ xmms>
</TargetServer>
</XmlRuntime>
</Entirex>
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Null Value Suppression

= |ntroduction

m Default Setting for Null Value Suppression

= Definition and Examples of Null Value Suppression Mode
= Default Definition of Null Value

Introduction

The EntireX XML/SOAP Runtime introduced a feature called null value suppression to reduce to
amount of data transferred between Web client and web service. Null value suppression (NVS)
allows you to hide tags or attributes with a specified value (so-called null value).

The different types of NVS are explained below. The EntireX XML Mapping Editor provides two
ways of setting/modifying the NVS type:

" using a general setting on tab Mapping Parameter

® on each element or attribute in the definition of request/response on tab XML Request/ XML
Response

For several data types, a null value is defined by default. See Default Definition of Null Value. To
change one of these null values, open the XML Request/ XML Response tab, select the element/at-
tribute and modify the property of the null value manually. For this modification use the Properties
view or the Properties dialog (open with the context menu).
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5 examnple.xmm &3 =g

M HPPing Parameters Restore Defaulks
¢ Document Style
¢ Encoding Settings

+ Mull ¥alue Suppression
Zontrol emphy elements or atkributes may be omitked in the XML documents,

Enable Mull Yalue Suppression

Simple Element: | Mo Suppression w
Simple Attribute: | Mo Suppression w
Array Tvpes: Zells ak End (Trim) w
Complex Types: | Suppress Group Elements W

Suppress Atkributes, iF Elerment has Mull Yalue

¢ Mamespace Definitions

Owerview | XML Request | %ML Response | Mapping Parameters | XML Samples

Default Setting for Null Value Suppression

Data Type Suppression Mode

Simple Elements |No Suppression

Simple Attributes|No Suppression

Array Types Cells at end (trim)

Complex Types |Suppress group elements

¢ Tip: The default setting for elements and attributes changed with version 7.3 from "Suppress

Element/Attribute" to "No Suppression". The null value suppression for elements and at-
tributes can be set independently. The null value suppression for Complex Types was intro-
duced with version 7.3.

Definition and Examples of Null Value Suppression Mode

If there is a significant difference between pure XML and SOAP for a null value suppression mode,
two examples are introduced.
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Suppression Mode Valid for

No Suppression Elements, attributes

Elements Elements

Attributes Attributes

Cells at End (Trim) Elements inside an array definition
All Empty Cells Elements inside an array definition
Suppress Group Elements|Elements inside a group definition
Depends On Element Attributes

No Suppression

The element or attribute is always present in document. The minimum and maximum occurrence
of element/attribute must be set to one.

Example 1

XML Document Displayed XML Document

<{prog> <{prog>
{integer>0</integer> {integer>0</integer>

</prog> </prog>

Elements

An element is hidden if

* the element value is equal to null value
= all attributes of the element can be suppressed

* the element has only subelements that can be suppressed

The minimum occurrence of element must be zero, and the maximum occurrence of element must
be one.

Example 2
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XML Document

Displayed XML Document

<prog>
<gr>
<integer>0</integer>
</gr>
</prog>

<prog />

Attributes

An attribute with null value is hidden.

The minimum occurrence of attribute must be zero, and the maximum occurrence of attribute

must be one.

Example 3

XML Document

Displayed XML Document

<prog integer="0" name="Henry"/>|<prog name="Henry"/>

Cells at End (Trim)

All elements of array that fulfills the assertion of "Suppress Element/Attribute" are suppressed if
its index is higher than the highest index of the non-suppressed element.

The minimum occurrence of elements must be lower than the maximum occurrence, and the
maximum occurrence of elements must be the maximum number of elements or unlimited.

<integer>0</integer>
{integer>1</integer>
<integer>0</integer>
dinteger>2</integer>
<integer>0</integer>
<integer>0</integer>
</array>
</prog>

XML Document Displayed XML Document
<prog> <prog>
<array> <array>

{dinteger>0</integer>
dinteger>1</integer>
dinteger>0</integer>
dinteger>2</integer>
</array>
</prog>
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All Empty Cells

All elements of array that fulfills the assertion of NVS_FIELD are suppressed.

The minimum occurrence of elements must be lower than the maximum of occurrence and max-
imum occurrence of elements must be maximum number of elements or unlimited.

Example 5a
XML Document Displayed XML Document
<prog> <{prog>

<array> <array>

<integer>0</integer>
dinteger>1</integer>
<integer>0</integer>
{integer>2</integer>
<integer>0</integer>
<integer>0</integer>
{/array>
</prog>

dinteger>1</integer>
dinteger>2</integer>
</array>
</prog>

Example 5b (for SOAP documents the XML/SOAP Runtime creates position attributes)

<integer>0</integer>
{integer>1</integer>
<integer>0</integer>
{integer>2</integer>
<integer>0</integer>
<integer>0</integer>
</array>
</prog>

SOAP Document Displayed SOAP Document
<prog> <prog>
<array> <array>

</array>
</prog>

<integer SOAP-ENC:position="[1]1">1</integer>
<integer SOAP-ENC:position="[3]">2</integer>

Suppress Group Elements

The suppression mode allows you to suppress group information if - and only if - all elements of

the group can be suppressed.

The minimum occurrence of elements must be zero.
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Example 6
XML Document Displayed XML Document
<prog> <prog>

<person> <person>

<firstname>Henry</ firstname >
<lastname>Miller</ lastname >
<somelnformation>2</ somelnformation >
<{/person>
<person>
{firstname></ firstname >
<{lastname></ Tastname >
<someInformation>0</ somelnformation >
</person>
<person>
{firstname>John</ firstname >
<{lastname>Miles</ Tastname >
<somelnformation>0</ somelnformation >
</person>
</prog>

<firstname>Henry</ firstname >
<{lastname>Miller</ lastname >
{somelnformation>2</ «
somelnformation >
</person>
<{person/>
<person>
<firstname>John</ firstname >
<lastname>Miles</ lastname >
<somelnformation>0</ «
somelnformation >
</person>
</prog>

Depends On Element

Attribute of the element is visible if the element does not have the null value.

The minimum occurrence of attribute and associated element must be zero, and the maximum

occurrence must be one.

Example 7
XML Document Displayed XML Document
<prog type="integer">0 <prog />

<parm type="integer">0</parm>
</prog>

Default Definition of Null Value

Data Types Null Value

String Empty String

Integer 0

Floating Point 0.0

Numeric 0.0

Time No default definition

Date No default definition
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Data Types Null Value

Binary No default definition

Boolean False

User-specified Settings

For further settings, use the method setUserProperty in XMLRPCService (EntireX XML/SOAP
Runtime).

Map Fault to IDL Parameter

= |ntroduction
= Example
= Testing the Fault Mapping

Introduction

The RPC Server for XML/SOAP maps the values of IDL parameters to XML/SOAP documents
and vice versa. If the web service responds with a fault document, this information is mapped to
an error and returned to RPC client normally. With the optional feature Map Fault to IDL Para-
meter you can map values from a normal response and also from a fault document response. This
means that no RPC error is returned to the RPC client; instead the fault information is contained
in the IDL file. An RPC error is returned to the client only if internal error processing problems
occurred within the RPC Server for XML/SOAP. This feature is available for SOAP and XML
documents.

Example

| Note: This example illustrates the feature Map Fault to IDL Parameter. Other features

mentioned here, such as renaming parameters or assigning a prefix/namespace to a para-
meter, are described elsewhere.
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Sample IDL File

/* Sample IDL file
library 'Demo' is
program 'FaultToIDL' is
define data parameter
1 MyRequest In
RequestData (AV)
MyResponse Qut
ResponseData (AV)
MyStatus Out ** parameters for fault information
Code (AV)
String (AV)
2 Detail (AV)
end-define

NN N =N

IDL-XML Mapping

~ To map fault items to IDL

1 Inthe XML Mapping Editor, generate a (SOAP) mapping and select the response tab.

ML Response

Mapping

= [e] i50ap-EMY:Envelope |
8] S0aP-EMY:Header
=[] SOAP-ENY:Body
=I-&] m:FaultTolDLResponse [ idlprog: FaultToIDL ]
=l 8] MyResponse [ idl:FaulkTolDL f MyResponse ]
8] ResponseData [ id:FaulkToIDL | MyResponse | ResponseData ]
=l [8] MySkatus [ idliFaultTalDL § MywSkakus ]
[8] Code [idl:FaultToIDL [ MwStatus |/ Code ]
[&] String [ idl:FaultToIDL | MwStatus | String ]
[e] Detail [id:FaultToIDL J MyStatus § Detail ]

2 Remove the parameter MyStatus, including its children, because the regular response will
not contain these parameters and the corresponding IDL parameters will be used for fault
information later.
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XML Response

Mapping

= [e] iS0AP-EMNY:Envelope |
[B] soaP-EMY:Header
=-[8] SOMP-ENY:Body
=[] m:FaultTalDlResponse [ idlprog: FaultTalIDL
=-[e] MyResponse [id:FaultTalDl | MyResponse ]
[8] ResponseData [idliFaultToIDL | MyResponse | Responsebata ]
[=)-[&] MySkatus [ idl:FaultTolDL | MySkatus ]
[8] Code [id:FaulkTolll | MyStatus | Code ]
[8] String [idl:FaultToIDL | MyStatus | Skring ]
[8] Detail [idl:FaultTolDL | MyStakus | Detail

+ Fault Document Manager

SOAP 1.1 Fault Document

Oweerview | XML Reguest | XML Response | Mapping Parameters | XML Samples

3 Open the Fault Document Manager (see bottom of opened tab Response) and select the doc-
ument to open the following wizard:

& EntireX XML Mapping Editor fg|

Fault Response

Mapping

SCAP-ENY:Envelope
[e] S0aP-ENY:Header
=-[8] SOAP-ENY:Bady

[=-[e] SoAP-EMY:Fault [ idlprog: FaultToIoL ]
[8] Faultcode [ info:faultcode ]
[] Faulkstring [ info:Faulkskring ]
[8] Faultactar [ info:faultactor ]
[] detail [ info:detail ]

Ok H Cancel ]

4 In the following steps, map "faultcode", "faultstring” and "detail" to IDL parameters. Fault
item "faultactor" is not used in this example.

5  Select "faultcode" and open the properties shown on the following screen:

EntireX XML/SOAP Wrapper 69



Writing Advanced Applications with the XML/SOAP Wrapper

6

T XML Mapping Editor

Elerment Marme:
Mapped Fault Tkem:

Fault Mapped ka IDL:

Forrnat:

Value Length:

Mamespace Prefix:

Default URI:

Mull Value Suppression:

XML Node Properties

Properties of faultcode [ info:Faultcode ]

| Faultcode

infoifaultoode

D =Mone

|string w |

| W [wariahle) |
vl

|ND Suppressian

Defaulk value:
Millable:

L]

O

Table of defined Mamespace definitions:

Prefix Mamespace

Default

Insert. ..

Edit...
Remove

Default

OF

H Cancel ]

Check Fault Mapped to IDL to enable the mapping path button. In this example, a mapping

path has not yet been entered and the button is labelled "<none>".
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& XML Mapping Editor

XML Node Properties

Properties of faultcode [ info:Faultcode ]

Elerment Marme: | faultcode

Mapped Fault Tkem: [ info:faultcode
Fault Mapped ka IDL: [ <Mone =
Forrnat: |string

Value Length: | W [wariahle)

Mull Value Suppression: |No Suppression

L]

Defaulk value: |
Millable: [F]

|
—H< =il LU L ‘1 Ed)

Mamespace Prefix: | |

Default URT: | |

Table of defined Mamespace definitions:

Prefix Mamespace Default Insert. ..

Edit...

Remove

Default

® Ok ] [ Cancel

7  Press the mapping path button.

& XML Mapping Editor

Currently not mapped
Change the IDL Mapping Path,

[]5how enly unmapped IDL Pathes:

FaultTallL

Fault TolDLMyResponse
FaultToIDLMyResponse/Responseata
FaultToIDLiMyStatus
FaultTaIDL My Status/Code

Fault ToIDL My Status/String
FaultTaIDL My Skatus/Detail

@ Ok H Cancel ]

8  Select the path to IDL parameter, for example "FaultToIDL/MyStatus/Code" and choose OK
to display the following screen:
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9

& XML Mapping Editor

XML Node Properties

Properties of faultcode [ info:Faultcode ]

Elerment Marme:
Mapped Fault Tkem:

Fault Mapped ka IDL:

Forrnat:

Value Length:

Mamespace Prefix:

Default URI:

Mull Value Suppression:

x]

| faultcode |
[ infoifaultcode ]
[ FaultToIDLiMyStatus/Cods |
|string w |
| Y {wariable) |
|ND Suppressian w |

Defaulk value:

Millable:

L]

O

Table of defined Mamespace definitions:

Prefix Mamespace

Default

Insert. ..

Edit...
Remove

Default

®@

OF

] [ Cancel

Choose OK.
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& EntireX XML Mapping Editor

Fault Response

Mapping

= [e] SOAP-EMY:Envelope
[8] SOaP-ENY:Header
=-[8] SOAP-ENY:Body
[=-[&] SOAP-EMY:Fault [ idlprog: FaultToIDL ]
B faultcods [ info:Faultcade ] [ idl:FaulkTalDL | MySkakus | Code ]
[8] Faultstring [ info:faultstring ]
[] Faulkactar [ info:faultackor ]
[8] detail [ info:detail ]

[0] 9 l[ Cancel ]

10 Repeat the steps above to select the fault items "faultstring” (path to IDL parameter e.g.
"FaultToIDL /MyStatus/String") and "detail" (path to IDL parameter e.g. "FaultToIDL /MyS-
tatus/Detail").

& EntireX XML Mapping Editor

Fault Response

Mapping

SOAP-ENY:Envelope
[8] SOaP-ENY:Header
=-[8] SOAP-ENY:Body

[=-[&] SOAP-EMY:Fault [ idlprog: FaultToIDL ]
[] Faultcade [ info:faultcode ] [ idl:FaulkToIDL | MySkatus | Code ]
[8] Faultstring [ info:faultstring ] [ idl:FaultToICL { MyStatus | String ]
[] Faulkactar [ info:faultackor ]
[8] detail [ info:detail 1 [ idl:FaultToIDL | MyStatus | Detail ]

[ [0] 9 l[ Cancel ]

| Note: The fault item "info:detail” contains the complete document fragment enclosed
by an associated tag (in this example tag <detail>).
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11 Choose OK to save the IDL-XML mapping.

In subsequent steps you need to

= Set up the RPC Server for XML/SOAP with this XMM.
" Set up a new web service or use an existing one.

Testing the Fault Mapping

As a quick test, implement a web service that behaves as follows:

= If the "requestData" field contains any data except "throwException", the field "responseData"
in the response document is set to a concatenation of the string "Receiving:" and the value of
field "requestData". See Request 2).

= If the "requestData" field contains "throwException", the web service responds with a SOAP
fault.
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Test Scenario

=
_

Service

Request 1 (Expecting Normal Response)

The following screen illustrates a request that expects a normal response:

EntireX Java RPC Tester for faulttoidl

File Help

Broker: lacahost: 1971 | Server: |RPCIXMLSERVER/CALLNAT |
[ cal |[ eing | [ open Conversation |
Messages

? RequestData (AY) |someData
2 ResponseData (AY)
2 Code (AW
2 String (AY)
= Detall (8Y)

The following response is received (field responseData is filled):
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EntireX Java RPC Tester for faulttoidl

File Help
Broker: |localhost:1971 | Server: RPCIXMLSERVER/CALLNAT |
[ cal J[ Fing ][ Open Conversation ] [ Reset ][ Exit ]
Messages

RequestData (AY) |someData

Responselata (AN Receiving: someData
Code (AY)

Skring (A
Detail (AY)

Request 2 (Expecting Fault Document)

The following screen illustrates a request where a fault document from the web service is expected:

EntireX Java RPC Tester for faulttoidl

File Help
Broker: lacahost: 1971 | Server: |RPCIXMLSERVER/CALLNAT |
[ cal |[ eing | [ open Conversation |
Messages

? RequestData (V) |throwException
? ResponseData (AY)
? Code (AY)
2 String (AY)

> Detail (AY)

The following fault information is provided:
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EntireX Java RPC Tester for faulttoidl ; E|f5__(|
File Help

Broker: ilncalhnst:l??l : Server: ERPC,I'XMLSER'-.-'ER,I'CALLNAT

[ ocall |[ Ring H Qpen Conversation [ Reset H Exit ]
Messages

2 RequestData (aY) |throwException
7 Responsebata (o)

2 Code (AY) axis2ns3: Server :
7 String (A% %ML Runtime Exception 2000 0001 Broker Exception: Caused by :RPC Server; java.lang.III
i Detail (AW e Entirel xmlns:exx="u:u:um.suftwareag.entirex.xml.rt":=-::Erru:urCIass:=-2IZIEIIZI=:,|'Err-:|rCIa:

Whitespace Handling

The XML/SOAP Runtime trims whitespace in values by default. The whitespace handling is also
determined by defining attribute xm1:space (see XML specification) on element(s). The attribute
xm1:space has the higher priority and is inherited from children of the element recursively.

This section covers the following topics:

= Attribute xml:space
= Changing the Default for Whitespace Handling

Attribute xml:space

The attribute xm1:space can be added in the XML Mapping Editor. Select an element and add
new child, select the checkbox for xml:space and choose OK. Depending on the application, perform
these steps for the request and/or response document definition. The attribute is added with value
"preserve". If another value is required, open the properties on the attribute and change the default
value.

| Note: The XML/SOAP Runtime only supports the value "preserve” for attribute xm1:space,
all other values disable the preserving of whitespace (that is, whitespace is trimmed).
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Changing the Default for Whitespace Handling

The steps required to keep whitespace as default depend on the EntireX component:

* Listener for XML/SOAP
Add the following line to file axis2.xml in WS-Stack Web application:

<parameter name="exx-xml-space">preserve</parameter>

= Java API (XMLRPCService)
Set the user property entirex.sdk.xml.runtime.xmlspace:

XMLRPCService rpcService = new XMLRPCService(...);

rpcService.setUserProperty("entirex.sdk.xml.runtime.xmlspace", "preserve");

® RPC Server for XML/SOAP
Add the following line to properties file of the RPC Server for XML/SOAP:

entirex.sdk.xml.runtime.xmlspace=preserve
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Writing Applications - Connect an Existing EntireX RPC Server with an XML-based Client

This chapter describes how to connect an existing RPC server with an XML-based client, using a
Web application that contains the EntireX XML/SOAP Runtime as part of Software AG Web Services
Stack, or using the Java API of EntireX XML/SOAP Runtime.

Connect RPC Server with XML-based Client, using a Web Application

Web Application Server

EntireX Client
RPC Server Frame

EntireX Runtime Environment

~ To generate the application, using a default SOAP mapping for the Web Service

= Select the IDL file that was used for creating the EntireX RPC server. From the context menu,
choose and Web Service > Generate Web Service... and follow the instructions given by the
wizard.
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~ To generate the application, not using an XML Mapping or a non-Default SOAP Mapping

1  Select the IDL file that was used for creating the EntireX RPC server and open it with the En-
tireX XML Mapping Editor.

2 Select the mapping and press Generate. Save the mapping file.

3 Depending on the tools used for the generation of the XML-based client, create an XML Schema
or WSDL for the generation of the XML-based client.

Select the IDL file, and from the context menu choose Web Service > Generate Web Service....

For the generation of the XML Schema file: Select the XMM file and open the context menu.
Choose Generate XML Schema (XSD)....
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Connect RPC Server with XML-based Client, using the Java API of EntireX
XML/SOAP Runtime

EntireX Client
RPC Server Frame
A A

EntireX Runtime Environment

~ To generate the application

1  Select the IDL file that was used for creating the EntireX RPC server and open it with the
EntireX XML Mapping Editor.

2 Select the mapping SOAP and press Generate. Save the mapping file.

3 Depending on the tools used for the generation of the XML-based client, create an XML Schema
or WSDL for the generation of the XML-based client.
Select the IDL file, and from the context menu choose Web Service > Generate Web Service....
For the generation of the XML Schema file: Select the XMM file and from the context menu
choose Generate XML Schema (XSD)....
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) Note: If this is not possible, write an XML-based client.

4  Create an XML-based client with a suitable tool. Follow the instructions on the screen, or
Generating Web Services from Software AG IDL File.

Running the Application

> To run the application

1  Start the EntireX Broker (if required).
2 Configure and start the EntireX RPC server (if not started already).

3 Run the client application.
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Writing Applications - Build an EntireX RPC Server and Use an Existing XML-based Client
with It

Generation Process

~ To generate the application

1 If a WSDL file or an XML Schema file for the XML-based client exists, use the IDL Extractor
for XML Schema or the IDL Extractor for WSDL, generating the IDL-XML mapping automat-
ically.

Otherwise, write a suitable IDL file.

2 Select this generated or written IDL file and open the context menu to generate the desired
server skeleton, or, if you are using Natural, write a Natural server.

Running the Application

~ To run the application

1  Start the EntireX Broker (if required).
2 Configure and start the EntireX RPC server or Natural RPC Server.

3 Run the client application.
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Writing Applications - Build an EntireX RPC Client and Use an Existing XML-based Server

Generation Process

EntireX
Client Frame

~ To generate the application

1 If a WSDL file or an XML Schema file for the XML-based server exists, use the IDL Extractor
for XML Schema or the IDL Extractor for WSDL, generating the IDL-XML-Mapping automat-
ically.

Otherwise, write a suitable IDL file.

2 Select this generated or written IDL and open the context menu to generate the desired client
frame or, if you are using Natural, write a Natural client.

Running the Application

~ To run the application

1 Configure the RPC Server for XML/SOAP. See RPC Server for XML/SOAP.
2 Start the EntireX Broker.
3  Start the RPC Server for XML/SOAP.
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4 Run the client application.
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Writing Applications - Connect an Existing EntireX RPC Client to an XML-based Server

Generation Process

EntireX
RPC Client

Server

Frame

EntireX Runtime Environment

~ To generate the application

1 Select the IDL file and open the context menu to create the EntireX RPC Client.

2 Select the IDL file and open with EntireX XML Mapping Editor. Select the mapping "SOAP"
and choose Generate. Save the mapping.
D Note: If an XML-based server does not exist, proceed as follows:

3  Depending on tools for generation of XML-based server create an XML Schema or WSDL for
generation of XML-based server.
Select the IDL file and open the context menu. Select Web Service > Generate Web Service....
For generation of XML Schema file: Choose File > Save XML Schema as.
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Create an XML-based client with a suitable tool and the WSDL / XML Schema file.

For generation of XML Schema file: Select the XMM file and in the context menu choose
Generate XML Schema (XSD)....

] Note: If this is not possible, write an XML-based server.

Running the Application

~ To run the application

1
2
3
4

Configure the RPC Server for XML/SOAP. See RPC Server for XML/SOAP.
Start the EntireX Broker (if required).
Start the RPC Server for XML/SOAP.

Run the client application.
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Configuring a Client to Call the EntireX XML/SOAP Runtime (Java API)

Configuration Information

The configuration information (which broker to use) is retrieved from the XMM file by default,
or the client sets this information explicitly.

For information on available methods, see XMLRPCService (EntireX XML/SOAP Runtime); for
available inherited methods, see RPCService (EntireX Java ACI).

For configuration of the behavior of XML/SOAP Runtime with setUserProperty see XMLRPCService.
Environment Settings

EntireX XML/SOAP Runtime requires correct setting for XML Stream Parser allowing access to
JAXP methods. The classpath must contain the required JAR files.

The Java properties are:

Javax.xml.stream.XMLInputFactory

(default: com.ctc.wstx.stax.WstxInputFactory)
Javax.xml.stream.XMLOutputFactory

(default: com.ctc.wstx.stax.WstxOutputFactory)

These must be set for the client application if they differ from the default settings.

Configuring a Client to Call the EntireX XML/SOAP Runtime (Listener for
XML/SOAP)

Configuration Information

The configuration information (for the EntireX Broker) is retrieved from one of the following
sources:

XMM file (lowest priority) by default

configuration xml-init.xml inside the web service description (AAR file) generated by Packaging
Wizard

" configuration of EntireX web service in an external configuration file

HTTP/payload parameters (highest priority)

See also Listener for XML/SOAP.
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Environment Settings

EntireX XML/SOAP Runtime requires correct setting for the XML Stream Parser to allow access
to JAXP methods. The classpath must contain the required JAR files. The Java properties are:

Javax.xml.stream.XMLInputFactory

(default: com.ctc.wstx.stax.WstxInputFactory)
Javax.xml.stream.XMLOutputFactory

(default: com.ctc.wstx.stax.WstxOutputFactory)

If the settings differ from the default settings, set them in the start script of the Web server.

Configuring an RPC Server for XML/SOAP

The RPC Server for XML/SOAP reads configuration data from configuration file (lowest priority),
property file and command line (highest priority). You can define location and name of property
file and configuration file as command-line parameters. The property file may define the JAXP
parameters and the location and name of the configuration file. Default for the properties file is
entirex.xmlrpcserver.properties and for configuration file entirex.xmlrpcserver.configuration.xml located
in the working directory. The configuration file (in XML format) contains information about EntireX
Broker and a list of target servers, including the mapping file associated with them. If a configur-
ation file or a properties file contains non-encrypted or base64-encoded passwords, the passwords
are replaced by the encrypted ones.

See RPC Server for XML/SOAP.
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Deployment to RPC Server for XML/SOAP and Dynamic Configuration of RPC Server for
XML/SOAP

Introduction

The Designer supports two methods of modifying the configuration of RPC Server for XML/SOAP:

® deploy an XMM to a specified RPC Server for XML/SOAP directly
* interact with RPC Server for XML/SOAP to perform configuration changes

The changes are activated immediately without restarting the RPC Server for XML/SOAP.

Notes:

1. Setting the property entirex.server.allowdevelopment in the XML/SOAP RPC Server's
properties file (default name: entirex.xmlrpcserver.properties) to "true" (default) enables deployment
and dynamic configuration; setting this property to "false" disables deployment and dynamic
configuration.

2. A deploy call with XMM and WSDL may transport a large amount of data. We therefore recom-
mend you increase the value of broker attribute MAX-MESSAGE - LENGTH in the attribute file.

Deploying an XMM File to RPC Server for XML/SOAP

~ To deploy an XMM file to RPC Server for XML/SOAP

1 Select an XMM file.

2 From the context menu, choose Deploy to EntireX XML/SOAP RPC Server ... to display the
following screen:
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XML/SOAP

£ XML/SOAP RPC Configuration

Select an existing or create a new RPC environment -
The selecked XMM File will be deploved in the Following $MLISOAR RPC Server #

This \Wizard will help vau to deploy inko a ¥MLISCAP RPC Server,
{:} Creake a new RPC Environment

G}'i_lse an exisking RPC Environment:

:EE localhost: 197 1@RPCXMLRPCSERYERDL JCALLMAT
:EE localhost: 1971 @RPCXMLRPCSERYERDS CALLMAT
:"E localhost: 197 1@RPCXMLRPCSERYERDZ [CALLMAT

3  Create a new RPC environment for Broker ID and server address or select an RPC Server for
XML/SOAP from the list.

& XML/SOAP RPC Configuration ._ |

. i
Deploy the XML Mapping file /Example/calc.xmm -
Mave the marked ¥MM file via drag-and-drop ko vour Favorite barget service
or ko the rook to creake a new target service,
Tree of the ¥MLS0AP RPC server configuration:
= @ localhost: 197 1@RPC/XMLSERVER JAYA
= B2 httpiyf
calc.xmm {D:h tempt example Example)
Target Service
LRL: "| hittp: )y w |
Mapping Cekails
WSOILISOAP Information
Default SOAP version: | 1.1 w |
WSDL name: | | Browse, .,
'i':’:' Mext = Finish ] [ Cancel
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XML/SOAP

4  Complete the configuration by adding URL and, optionally, the WSDL file. If a WSDL file
with same name exists in directory, the field is filled by default. Choose Finish.

Undeploying an XMM File from RPC Server for XML/SOAP

~ To undeploy an XMM file from RPC Server for XML/SOAP

1  Select an XMM file.

2 From the context menu, choose Undeploy from EntireX XML/SOAP RPC Server ... to display

the following screen:

& XML/SOAP RPC Configuration

The selected XM File will be deploved in the Following XMLISCAP RPC Server

This wizard will help vou to deploy inko & XMLISOAP RPC Server,
O Create a new RPC Environmment

@Llse an exisking RPC Environment; |

8 lacalhost: 197 1 @RPC/XMLSERVER JAYA

Select an existing or create a new RPC environment i

2 Einish ] [ Cancel

l

3  Create a new RPC environment for broker ID and server address, or select an RPC server

from the list.

4  Choose Finish.
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Configuring RPC Server for XML/SOAP Dynamically

~ To configure an XML/SOAP RPC Server dynamically

1 From the Window menu, choose Preferences to display a screen similar to the one below:

= Preferences = |-
type filter text RPC Environments for RPC Server for XML/SOAP SPrr -
Software AG -
400 .are Manage the RPC Environments for RPC Server for XML/SOAP.
» Ajax Developer
APL-Portal Table of defined RPC environments:
» Business Services Name : Broker D Server Address Insert..
» Code Generation XM /SOAP RPC 5i localhost:1971 RPC/XMLSERVER/CALLNAT
. Construct L L/ Erver ocalhost: S/ R/
b XML/SOAP RPC Server (2) localhost:1971 RPC/XMLSERVEROL/SOAP f
ocument Expansion R

.

EntireX Duplicate
> COBOL P

> Natural

> PLI

4 Web Services
RPC Envirenments for RPC Server for XML/SOAP
‘Web Service Wrapper
XML Mapping Editor

> Wrappers

®®

1

2 Select an XML/SOAP RPC Server environment or create a new one.
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& RPC Environments

Edit RPC Environment for XML/ SOAP RPC Server
Change the RPC Environment,

Broket Parameters

Broker ID: GI

ocalhosk: 1971 |

Server Address: T RPC/RMLSERYER]JAYA

Timeout (Seconds): | ) |

Enkirel Authentication RPZ Server Authentication

Extractor Settings

Wrapper Settings

Skaow Save Save local

Environment: Mame
() Default

() ather: | localhost: 197 L@RPCAMLSERVER | JAY 4

] < Back Mext = l I Einish ] [ Cancel

l

3 Choose Next to view or manage the configuration of web services.
& RPC Environments
XNML/SOAP RPC Server 4=
Manage the ¥MLISOAP RPC Server configuration
Tree af the ¥MLSOAP RPC server configuration:
= :-;"E localhiost: 197 L@RPCEMLSERYER ) JAYA add. ..
= hkkp: fflocalhost: 49981 wsstack)services/cal:
calc.xmm (:kemplexamplel Example)
':':’:' Mext = Einish l [ Cancel ]
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4  The second wizard page allows you to add, modify and remove service addresses and their
configuration as well as add, modify and remove XMM file in the selected configuration. The
graphical user interface supports drag-and-drop operations.

EntireX XML/SOAP Wrapper 105



106



18 Examples

= Example 1: Existing Natural Client that Connects to @ Web Service ... 108
= Example 2: Publish an EntireX RPC Server for Web CENts .............coooiiviiiiiiiiiiiiiiiccceeeeccciiieee e 112

107



Examples

Example 1: Existing Natural Client that Connects to a Web Service

Natural Program

* CALC : CLIENT *
¥ cococcocoococcoocococoocoocoooocoCoCCoOCOCCoOCOCCoOCOCCoOCOCCoOCOOCCSOCOOCCoOCOCCoOCOCCSCOooooo *
DEFINE DATA
LOCAL
01 #OPERATOR (A1)
01 #OPERANDI (14)
01 #fOPERANDZ (14)
01 #RESULT (14)
*
01 #MSG (A60)
END-DEFINE
A g g g *

ASSIGN #fOPERAND1 = 12345

ASSIGN #fOPERATOR = '+

ASSIGN fFOPERAND?2

ASSIGN #fRESULT =0

*

CALLNAT 'CALC' #0PERATOR (AD=0)
J#OPERAND1  (AD=0)
#fOPERAND2  (AD=0)
#FRESULT (AD=A)

Il
(o))
~l
(0¢)]
O
(@]

*

COMPRESS #OPERAND1 ffOPERATOR #fOPERAND2 '=' {RESULT
INTO #MSG LEAVING NO SPACE

*

PRINT #MSG

® Use the IDL Extractor for Natural to get the IDL file. In the EntireX perspective, use New >
IDL Extractor for Natural . In other perspectives, use New > Other... > Software AG > IDL Ex-
tractor for Natural.
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Software AG IDL

Library 'Example' Is
Program 'Calc' Is
Define Data Parameter

1 Operator (A1) In
1 Operand_1 (I4) In
1 Operand_2 (I4) In
1 Function_Result (I4) Out
End-Define

® Select the IDL file and open the context menu.

® Choose Web Service > Generate Web Service..., and the XMM and WSDL file will be generated.
See Web Services Wrapper.

Example.wsdl

<?xml version="1.0" encoding="utf-8"7>
<definitions name="example" <
targetNamespace="http://namespace.softwareag.com/entirex/xml/mapping"
xmlins="http://schemas.xmlsoap.org/wsdl/" <
xmlns:xsd="http://www.w3.0rg/2001/XMLSchema"
xmlns:soap="http://schemas.xmlsoap.org/wsdl/soap/" «
xmins:soapl2="http://schemas.xmlsoap.org/wsdl/soapl2/"
xmIns:wsdl="http://schemas.xmlsoap.org/wsdl/" <
xmlns:SOAP-ENC="http://schemas.xmlsoap.org/soap/encoding/"
xmlIns:tns="http://namespace.softwareag.com/entirex/xml/mapping" <«
xmlns:sn0="urn:com-softwareag-entirex-rpc:EXAMPLE">
{types>
{xsd:schema targetNamespace="urn:com-softwareag-entirex-rpc:EXAMPLE">
{xsd:element name="CALC">
<xsd:complexType>
{xsd:sequence>
{xsd:element name="Operator" type="xsd:string"/>
{xsd:element name="Operand_1" type="xsd:int"/>
{xsd:element name="Operand_2" type="xsd:int"/>
</xsd:sequence>
</xsd:complexType>
</xsd:element>
<{xsd:element name="CALCResponse">
<xsd:complexType>
<{xsd:sequence>
{xsd:element name="Function_Result" type="xsd:int"/>
</xsd:sequence>
</xsd:complexType>
</xsd:element>
<{/xsd:schema>
</types>
<message name="CALCSoapIn">
<part name="parameters" element="sn0:CALC"/>
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<{/message>
<message name="CALCSoapQut">
<part name="parameters" element="sn0:CALCResponse"/>
<{/message>
<portType name="EXAMPLEPort">
<operation name="CALC">
<input message="tns:CALCSoapIn"/>
<output message="tns:CALCSoapQut"/>
<{/operation>
</portType>
<binding name="EXAMPLESOAP11Binding" type="tns:EXAMPLEPort">
{soap:binding style="document"
transport="http://schemas.xmlsoap.org/soap/http"/>
<operation name="CALC">
<soap:operation soapAction="CALC"/>
<input>
<soap:body use="literal"/>
</input>
<output>
<{soap:body use="literal"/>
</output>
<{/operation>
</binding>
<binding name="EXAMPLESOAP12Binding" type="tns:EXAMPLEPort">
<soaplZ:binding style="document" <
transport="http://schemas.xmlsoap.org/soap/http"/>
<operation name="CALC">
<soaplZ:operation soapAction="CALC"/>
<input>
<soaplZ:body use="Titeral"/>
</input>
<output>
<soaplZ2:body use="literal"/>
</output>
</operation>
</binding>
{service name="example">
<port name="EXAMPLESOAPI1Port" binding="tns:EXAMPLESOAP11Binding">
<{soap:address location="http://localhost:10010/wsstack/example"/>
</port>
<port name="EXAMPLESOAPI2Port" binding="tns:EXAMPLESOAP12Binding">
<{soaplZ2:address location="http://localhost:10010/wsstack/example"/>
</port>
<{/service>
</definitions>

® Create a service skeleton with Apache Axis.
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Java -classpath org.apache.axis.wsdl.WSDL2Java --server-side --skeletonDeploy true <«
Example.wsd]l

® And write an implementation of this service.

/**

* Service.java

*

* Implementation of ExamplePort

* generated by the Apache Axis WSDL2Java emitter.
=)

package com.softwareag.namespace;

public class Service implements ExamplePort
{
public int calc(java.lang.String operator_, int operand_1, int operand_2)
throws java.rmi.RemoteException
{
int result = 0;
if (operator_.equals("+"))
{
result = operand_1 + operand_2Z;
}
else if (operator_.equals("-"))

result = operand_1 - operand_2;
else if (operator_.equals("*"))
result = operand_1 * operand_2;

else if (operator_.equals("/"))
{
result = operand_1 / operand_2;
}
return result;
}
}

® Build and deploy the service (see Apache Axis documentation).

® Configure the RPC Server for XML/SOAP
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entirex.xmirpcserver.properties

## jaxp parameters

f# if jaxp properties are not set in system properties

#

# xmlruntime configuration file
entirex.sdk.xml.runtime.configurationfile=.entirex.xmlrpcserver.configuration.xm]l

entirex.xmlrpcserver.configuration.xml

<?xml version="1.0" encoding="iso0-8859-1" 7>
<{EntireX
xmIns="http://namespaces.softwareag.com/entirex/xml/runtime/configuration" <
version="7.1.1">
<XmlRuntime Version="1">
<{BrokerInfo>
<BrokerId>Tocalhost:1971</BrokerId>
<ServerAddress>RPC/SRV1/CALLNAT</ServerAddress>
</BrokerInfo>
<TargetServer name="http://localhost:8080/axis/services/ExamplePort">
<XmmList>
<!-the name of XMM file-->
<Xmm name="./Calc.xmm" />
</ XmmList>
{/TargetServer>
</ XmTRuntime>
</EntireX>

= start the RPC Server for XML/SOAP:

java com.softwareag.entirex.xml.rt.XMLRPCServer

Example 2: Publish an EntireX RPC Server for Web Clients

Software AG IDL File

library 'UserList' is
program 'Add' is
define data parameter
1 Name (AV) In
end-define

program 'Retrieve' is
define data parameter
1 Name (AV/V) Out
end-define
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~ To publish the EntireX RPC/SOAP server

1  Create a new IDL file User List (Using: New > Software AG IDL file or New > Others ... >
Software AG > Software AG IDL file).

2 Select the IDL file and generate the RPC server from the context menu.

3  Select the IDL file, and from the context menu choose Web Service > Generate Web Service....
Generate and deploy the AAR file with the Packaging Wizard.

4  Select the tab XML Samples in the EntireX XML Mapping Editor and save one or all sample
documents.

5  Select the request document in the tree and open the XML Tester with the context menu.

| Tasks XMLTester pcs RP‘C Environment Monitor EntireKDefauIt Broker S I = O

+ Target and Environment Area

@ HTTP Test (XML/SOAP Listener) HTTP URL  http:/flocalhost10010/wsstack/services -
() Direct Test pY LY Y- R D workspace\ examplexmm -- Browse...

Document Area (Request and Response)
Tree View | Text View | Raw View

<%xml version="1.0" encoding="UTF-8" =

<!-- Generated by Software AG, EntireX XML Mapping Editor (10.5.0.0) on 2018-11-21 at 08:22:53 --=

<m:CALC xmins:m="urn:com-softwareag-entirex-rpcEXAMPLE-CALC" =
<Operation>+</Cperation=
<(Operandl »21</Operandl >
<Operand2»6</Operand2»

</mCALC>

o4

Tree View | Text View | Raw View

Input XML Document:
a3

b

)

6  Change the URL to the required address, for example: http://localhost:10010/wsstack/services/ex-
ample. Choose Send. The response document will be displayed in the lower portion of the
screen.
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Frequently Asked Questions (FAQ) and Troubleshooting

Listener for XML/SOAP

® If you receive message 2000 0007: Incoming XML document is invalid, there could be a dif-
ference between the mapping and the document, for example an element-preferred mapping
(XMM file) does not match the SOAP document.

* Deploying/calling an EntireX web service fails with
com.softwareag.wsstack.ui.deployment.DeploymentException:
com.softwareag.entirex.xml.rt.WSSServicelLifeCycle.

For the Listener for XML/SOAP you need to set up a Web server and install Software AG
Common Web Services Stack to this Web server. See Installing Web Services Stack in a Web Server.

After successful installation: If entirex.jar was not added to wsstack.war, copy or upload
inst_d1ir/EntireX/classes/entirex.jar to the WEB-INF/Iib folder in the Web Services Stack application
folder.

RPC Server for XML/SOAP

" Server does not start
® Check classpath
= If a file is not found:
® Check location of property file, configuration file or XMM(s)

= RPC Server for XML/SOAP starts but receives an HTTP error for several reasons. Check the re-
ceived information fault document. If there is no information fault document, start RPC Server
for XML/SOAP again with trace (level = ADVANCED) and analyze the trace (look for the fault
document).

" RPC Server for XML/SOAP gets the following error message: "Caused by:
java.lang.ClassCastException: org.apache.xerces.jaxp.SAXParserFactoryImpl cannot
be cast to javax.xml.stream.XMLInputFactory". To correct the error, modify the properties
file by redefining the parameter for the XML stream parser as follows:

entirex.sdk.xml.runtime.xmlparserfactory=com.ctc.wstx.stax.WstxInputFactory

" RPC Server for XML/SOAP gets the following error message: "Error 2000 0082: Unknown RPC
Tibrary or RPC program. ...". Check that the XMM file containing this library/program is
added to the RPC Server for XML/SOAP configuration file, that is, the required TargetServer
section is not commented out.
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| Note: The default configuration file (entirex.xmlrpcserver.configuration.xml) contains the
sample section TargetServer, which is commented out.

In any case, check the following;:

® Configuration file: TargetServer attribute “name” is not fully qualified
® Name may require a domain specification

® Name only contains target without service specification or/and with wrong port (non-default
port)

" Mapping
® Mapping does not match service requirements
® SOAPAction value is wrong or undefined
® Connection cannot be established or connection failed
" Wrong HTTP setting
Change / set Java properties http.proxyHost, http.proxyPort, httpsproxyHost,
https.proxyPort

® Application error (service side)

RPC Server for XML/SOAP in the Software AG Runtime

Use file <installation home>/profiles/ CTP/configuration/logging/log_config.xml to configure the logging
settings. The log file sag-0sgi.log or wrapper.log is written to directory <installation home>/pro-
files/CTP/logs.

To analyse the log, search for lines containing "EXX" and check the status/error:

EXX: Configuration Error: Reading configuration file fails.
Explanation The entirex.servers.properties cannot be loaded.

Action The file must be located in directory <installation home>\ EntireX \etc\exx \workspace
and be accessible.
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EXX: Reading configuration fails: File does not exist.
Explanation The file entirex.servers.properties cannot be found.

Action Validate the installation.

EXX: XML/SOAP RPC Server does not start. Reason: :1:".

Explanation The server cannot start for reason :1:.

Action 1. Validate the properties and configuration file settings (see also log).
2. Validate if the properties and configuration are correct.

3. Validate if the paths of XMM files in configuration file are correct and the files are
accessible.
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Client Using the Java Interface

See also the delivered example XMMInvoker and XMLRPCService (EntireX XML/SOAP Runtime).

Step 1: Writing the Client Program

~ To write the client program

1

Initialize the Broker Object:

Broker broker
// if a logon

should be issued

broker.logon(password) ;

Initialize the XMLRPCService Object:

XMLRPCService
service = new

or

XMLRPCService
service = new

service;

new Broker(brokerID,

userlID);

XMLRPCService(xmmfilename);//constructor with XMM

service;
XMLRPCService(broker,

Initialize the Conversation Object:

serverName,

xmmfilename);

For one XMLRPCService, only one conversation may be used at a time.

private Conversation conv;
conv = new Conversation(service);

Assign the incoming XML document:

String xmlDocument = "<?xm]
"<CALC Operation=\"-\" Operand_1=\"1000000611\"

Operand_2=\"1000000288\"></CALC>";

Invoke the Service.

Non-conversational:

version="1.0" encoding="1s08859-1"7>" +

120
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try
{
String result = service.invokeXML(xmlIDocument);
iatch (XMLException e)
{ // Error handling ...
iatch (BrokerkException e)
{ // Error handling ...
iatch (Exception e)
{ // Error handling ...
}

Conversational:

try
{
service.setConversation(conv) ;
String result = service.invokeXML(xmlFromFile(filename));
service.closeConversationCommit();
}
catch (XMLException e)
{
// Error handling ...
}
catch (BrokerException e)
{
// Error handling ...
}
catch (Exception e)
{
// Error handling ...
}

The string result contains the returned document. It should be:

<CALC Function_result="899" />

EntireX XML/SOAP Wrapper 121



Reference - HTTP and Java Interface

Step 2: Running the Client Program

The definition of the Java classpath must include

® the generated XMM file, see Generating an XMM File
" the entirex.jar file (delivered in the directory <EntireX Home>/classes)

* the files for an XMLStreamParser, for example the delivered wstx-asl.jar and stax-api.jar (in the
directory <EntireX Home>/classes)

The Java Interface

Class XMLRPCService

XMLRPCService extends com.softwareag.entirex.aci.RPCService.See XMLRPCService (EntireX
XML/SOAP Runtime).

The HTTP Interface

The Listener for XML/SOAP supports HTTP POST Request and HTTP GET Request. The following
HTTP headers and parameters are available. Use them from the EntireX XML Tester or other third-
party XML tools:

Header/Parameter Direction | Description

exx-brokerID IN If this attribute is set, it overwrites both the properties of the XMM file
and the settings of the servlet initialization.

exx-service IN The service name is the triplet of server class/server name/service. If
this attribute is set, it overwrites both the properties of the XMM file
and the settings of the servlet initialization.

exx-userlD IN The user ID specified here is used for calling the broker.

exx-password IN The password specified here is used for calling the broker.

exx-use-security IN Deprecated. An internal automatic routine makes this parameter
obsolete. Possible values: true | false.

exx-rpc-userlID IN The RPC user ID specified here is used for Natural Security. If no RPC

user ID and no RPC password is defined, the values of exx-userID
and exx-password are used for these values.

exx-rpc-password IN The RPC password specified here is used for Natural Security. If no
RPC user ID and no RPC password is defined, the values of
exx-userIDand exx-password are used for these values.
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Header/Parameter

Direction

Description

exx-natural-security

IN

Possible values: true | false. Determines whether Natural Security
is used. See Using the Broker and RPC User ID/Password.

exx-natural-Tibrary |IN The Natural library. Applicable only if exx-natural-security is
"true". See Using the Broker and RPC User 1D/Password.

exx-use-codepage IN Determines the encoding the Listener for XML/SOAP uses to
communicate with EntireX Broker. See RPC Call (Broker Request) in the
Listener for XML/SOAP documentation.

exx-compresslevel IN Sets the compression level. See Using Compression under Writing
Advanced Applications - EntireX Java ACIL.

exx-compression IN Possible values: true | false. See Using Compression.

exx-xml-sessionlD IN OUT |This HTTP header is returned from the servlet to the client application.
If the client returns it to the servlet with the preceding call, the same
session will be used. For conversations, the exx-conv parameter is
also required.

exx-xml-info OUT  |In this HTTP header additional information is returned.

exx-xml-error OUT  |In this HTTP header error information is returned.

exx-conv IN Possible values: OPEN | COMMIT | BACKOUT.
Conversations can only be used in connection with sessions. If the
session is interrupted, the conversation is deleted.

exx-reliable IN Possible values: AUTO-COMMIT | OFF.
See Reliable RPC for XML/SOAP Wrapper.

exx-messagelD OUT  |The message ID of the RPC request (if available).

exx-correlationlID OUT  |The message ID of the RPC reply (if available).

EntireX XML/SOAP Wrapper
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XML Structures and IDL-XML Mapping

To understand the functionality and usage of the XML Mapping Editor, it is necessary to look at
the possible XML structures and how they are mapped to Software AG IDL.

XML Structure Description

An XML structure is the type of an XML document, that is, the blueprint to build or parse the
XML document. Every program of every library within a Software AG IDL file corresponds to at
least two XML structures: one for the incoming and one for the outgoing XML document. The
Error or Fault directions are also described as XML structures. There are InErr and OutErr XML
structures that are returned by the broker or server in case of broker or data errors or servicing
problems. The XML structures all start with one root node (corresponding to the library/program
combination of the Software AG IDL file), and all XML elements and attributes are linked under
that root node and may be further cascaded.

The XML structure may be represented as a tree of XML structure nodes (so-called XML parts).
For the EntireX XML/SOAP Wrapper, no cyclic XML structures (that is, non-tree XML structures)
are allowed because mapping to Software AG IDL parts would be illegal. However, in general
this is not a severe restriction because Software AG IDL parts may not be cyclic either.

The XML parts have various properties. Important properties are the node name (tag name) and
the node type (element or attribute). Other properties are the data type and length, minimum and
maximum occurrence, the default values, the encoding, or the used or defined namespace. XML
parts may have links to IDL nodes (their IDL mapping links, see below).

In the XML Mapping Editor, the XML structures are displayed as node trees. For XML structures,
sample XML documents can be generated to visualize the expected or generated XML documents.

Basic IDL-XML Mapping

Mapping between IDL and XML describes the location of the data in the XML documents that
correspond to the RPC parameters. Getting data for the RPC request is called incoming direction,
putting RPC response data into an XML document is called outgoing direction. RPC parameters
can correspond to elements or attributes.

There are various basic strategies for generating elements or attributes from a given Software AG
IDL. The most important strategies are:

* Element-preferred mapping: Model the library/program and every IDL parameter as an element.
The elements are cascaded in the same way as their IDL counterparts. The tree of IDL parts and
the tree of XML elements are very similar. Arrays or repeated groups may get envelope elements.
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® Attribute-preferred mapping: Model the library/program as root element. Model Arrays and
repeated groups as elements, possibly with envelope elements around them. Model all other
IDL parameters as attributes.

" SOAP: Construct a SOAP message format according to the SOAP specification. Every Software
AG IDL part relates to an element in the SOAP:Body portion. Further fine-tuning according to
the specification may be done.

Some users prefer element modeling, others like to add attributes to existing elements wherever
possible. To minimize the work of building XML structures in the XML Mapping Editor, default
mappings are available. The XML Mapping Editor allows you to choose an element-preferred, an
attribute-preferred or a SOAP-conformant strategy (plus various detail level switches). The element-
preferred mode generates only element nodes, whereas the attribute-preferred mode generates
attributes wherever possible.

Example

= DL File

= Element-preferred Mode

= Attribute-preferred Mode

= SOAP-conformant Mapping

IDL File

Library 'EXAMPLE' Is
Program 'CALC' Is
Define Data Parameter
1 Operation (Al) In
1 Operand_1 (I4) In
1 Operand_2 (I4) In
1 Function_result (I4) Out
End-Define

Element-preferred Mode

In the element-preferred mode, the IDL is mapped to the incoming XML document:

<CALC>
<Operation> ... </Operation>
<Operand_1> ... </Operand_1>
<Operand_2> ... </Operand_2>
</CALC>

and the outgoing XML document:
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<CALC>
{Function_result> ... </Function_result>
</CALC>

The corresponding XML structure trees are:

=|--[&] im:CALC [ idlprog: CaLC ];
[e] Operation [ id:CaLC | Operation ]
[e] Operand_1 [idkCALC | Operand_1 ]
[e] Operand_2 [id:CALC | Operand_2 ]

and

=|-[e] im:CALC [ idlprog: CALC ]
[8] Function_Result [ id:CaLC ! Funckion_Result ]

Attribute-preferred Mode

In the attribute-preferred mode, the Software AG IDL above is mapped to the incoming XML
document:

<CALC Operation="..." Operand_1="..." Operand_2="..."/>

and the outgoing XML document.

<CALC Function_result="..."/>

The corresponding XML structure trees are:

=|-[e] im:CALC [ idlprog: CALC ]
Cperation [ id:CALC [ Operation ]
Operand_1 [id:CALC [ Operand_1 ]
Operand_2 [id:CALC [ Operand_Z ]

and

= [&] im:CALC [idiprog: CALC ]
Funckion_Result [ idl:CaLC | Funckion_Result ]
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SOAP-conformant Mapping

In SOAP-conformant mapping or the SOAP-conformant mode, the above Software AG IDL is
mapped to the incoming XML document:

<SOAP-ENV:Envelope xmlns:SOAP-ENV="http://schemas.xmlsoap.org/soap/envelope"
xmins:SOAP-ENC="http://schemas.xmlsoap.org/soap/encoding"
xmins:xsi="http://www.w3.0rg/2001/XMLSchema-instance"
xmlns:xsd="http://www.w3.0rg/2001/XMLSchema"
SOAP-ENV:encodingStyle="http://schemas.xmlsoap.org/soap/encoding">
<SOAP-ENV:Header></SOAP-ENV:Header>
<SOAP-ENV:Body>
<CALC>
<Operation xsi:type="SOAP-ENC:string">...</Operation>
<Operand_1 xsi:type="SOAP-ENC:int">...</Operand_1>
<Operand_2 xsi:type="SOAP-ENC:int">...</Operand_2>
</CALC>
</SOAP-ENV:Body>
</SOAP-ENV:Envelope>

and the outgoing XML document:

<SOAP-ENV:Envelope xmlns:SOAP-ENV="http://schemas.xmlsoap.org/soap/envelope"
xmins:SOAP-ENC="http://schemas.xmlsoap.org/soap/encoding"
xmins:xsi="http://www.w3.0rg/2001/XMLSchema-instance"
xmlins:xsd="http://www.w3.0rg/2001/XMLSchema"
SOAP-ENV:encodingStyle="http://schemas.xmlsoap.org/soap/encoding">
<SOAP-ENV:Header></SOAP-ENV:Header>
<SOAP-ENV:Body>
<CALCResponse>
<Function_result xsi:type="SOAP-ENC:int">...</Function_result>
</CALCResponse>
</SOAP-ENV:Body>
</SOAP-ENV:Envelope>

The corresponding XML structure trees:

- [€] S0AP-ENY:Envelope:
SCAP-EMY:encodingStyle
--[&] SCAP-EMY:Header
[e] soaPaction [idprog: CaLcC ]
—|-[e] SCWP-EMY:Body
—|-[&] m:CaLC [ idprog: CaALC ]
—|--[e] Cperation [idl:CALC | Operation ]
xsitbype
[8] ©perand_1 [id:CaLC | Operand_1 ]
xsitbype
[e] ©perand_2 [id:CALC | Operand_2 ]
xsitbype
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and

=1 [€] iSCAP-ENY:Envelope:
SOAP-ENY: encadingStyle
[8] SoaP-EMY:Header
- [&8] SOAP-ENY:Body
—-[&] m:CALCResponse [idprog: CALC ]
=[] Function_Result [idl:CALC f Function_Result ]
wsiibype

Arrays

The IDL may contain array parameters, that is, basic data types that are to be repeated for a specified
number of times. See following example:

1 Operation (Al/5) In

The Operationmay be repeated 5 times. In this case Operation must correspond to an XML element,
because with attributes the repetition cannot be modelled. The corresponding XML document
may then contain up to 5 Operation elements:

<Operation>
<Operation>
<Operation>
<Operation>
<Operation>

</0peration>
</Operation>
</0peration>
</0peration>
</0peration>

or it may contain a surrounding parent element (envelope) Operation:

<Operations>

<Operation>
<Operation>
<Operation>
<Operation>
<Operation>

</0peration>
</Operation>
</0peration>
</0Operation>
</0peration>

</Operations>

A switch in the XML Mapping Editor determines whether arrays get a surrounding parent element
or not.
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There is a maximum of three dimensions per IDL array. Each of the dimensions can have upper
and lower bounds defined. The format is as follows:

1 Operation (A1/3,6,8) In

which corresponds to a possible XML document:

<Operationsl>
<Operations2>
<Operations3>
<Operation> ... </Operation>
</0Operations3>
</0perations2>
</0perationsl>

and XML structure:
Operationsl (element)
Operations2 (element, minocc=1, maxocc=3)

Operations3 (element, minocc=1, maxocc=6)
Operation (element, minocc=1, maxocc=8)

Groups

The IDL may contain entries that represent groups of parameters.

Example

Library 'EXAMPLE' Is
Program "ADD' Is
Define Data Parameter
1 Parameters In
2 Operand_1 (I4)
2 Operand_2 (I4)
1 Function_result (I4) Out
End-Define

The entry parameters are a group of two Operands. Groups will always be converted to XML
elements; the group elements will be mapped either to elements or to attributes.
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Element-preferred mode

<ADD>
{Parameters>
<Operand_1> "..." </Operand_1>
<Operand_2> "..." </Operand_2>
</Parameters>
</ADD>

Attribute-preferred mode

<ADD>
<Parameters Operand_1="..." Operand_2="..."/>
</ADD>

Array of Groups
Groups can be used in arrays, for example:

1 myparams (/5,4) In
2 Operation (I4)
2 Description (A80)
2 Mygroup
3 Operand_1 (I2)
3 Operand_2 (I2)
2 Options (Al/4)

Using the element-preferred mode, this IDL structure may be mapped to:

<Myparms1>
<Myparms2>
<Myparms>
<Operation> "..." </Operation>
<Description> ." </Description>
<Mygroup>
<Operand_1> "..." </Operand_1>
<Operand_2> "..." </Operand_2>
</Mygroup>
<Optionsl>
<Options>"..."</Options>

</Optionsl>
</Myparms>

</Myparms2>
</Myparms1>

The corresponding XML structure for the element-preferred strategy is then:
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Myparmsl (element)
Myparms2 (element, minocc=1, maxocc=5)
Myparms (element, minocc=1, maxocc=4)
Operation (element, I4)
Description (element, A80)
Mygroup (element, group, minocc=1, maxocc=1)
Operand_1 (element, 12)
Operand_2 (element, 12)
Optionsl (element, minocc=1, maxocc=4)
Options (element, Al)

Grouping XML Elements or Attributes

You can introduce new elements by grouping one or more existing elements or attributes.

This is especially useful when the IDL contains many simple data types that could be semantically
grouped. This will increase the level of hierarchies in the XML document without affecting the
IDL.

Example

Library 'EXAMPLE' Is
Program 'SIMPLE" Is
Define Data Parameter
1 parl (A1) In
par2 (Al) In
par2l (Al) In
par22 (I1) In
par23 (I4) In
par3 (Al) In
par3l (I2) In
par32 (I4) In
pard (I1) In
1 par5 (A1) In
End-Define

= S ) e e

will be transformed by the attribute-preferred strategy to:

<SIMPLE parl="..." par2="..." par2l="..."
parz2z="..."

par3="..." par31="..." par32="..."
pard="..." parb="..."/>

or with the element-preferred strategy to:
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<SIMPLE>
<parl> ... </parl>
<par2> ... </par2>
<par2l> ... </par2l>
<par22> ... </par22>
<parz23> ... </par23>
<par3> ... </par3>
<par3l> ... </par31l>
<par32> ... </par32>
<pard> ... </pard>
<par5> ... </parb>

<SIMPLE>

You can now reorganize the XML structure, for example to:

<SIMPLE parl="..." pard4="..." parb="...">
<par?2 par2l="..." par2z2="..." par23="...">... </parZ>
<par3 par3l="..." par32="..."> ... </par3>

</SIMPLE>

IN /OUT /IN OUT Parameters

The incoming XML request must correspond to the incoming IN and IN OUT IDL parameters, and
the (created) outgoing XML response must contain the IN OUT and 0UT IDL parameters. In the in-
coming XML structure, there is no difference between IN and IN OUT parameters; the same applies

to IN OUT and OUT parameters for the outgoing XML document.

Make sure that all IDL parameters marked as IN are properly mapped to (incoming) XML parts.
Otherwise, the XML/SOAP Runtime can only assign a null representation (value “0”, empty string,
Boolean “false” etc.) to the respective unmapped IDL parameters. This is probably not the desired
value to be sent to the server. The XML Mapping Editor issues a warning when unmapped IN

parameters are found.
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XML Schema Standards Conformance (XML/SOAP Wrapper)

XML Schema Parser Standards Conformance

The XML Schema styles "Garden of Eden", "Russian Doll", "Salami Slice" and "Venetian Blind" are
supported. Each xsd:element declaration containing at least one xsd:element or xsd:attribute
will be interpreted as an IDL program.

Supported Features

* Element declaration

" Model group definition: group

® Model groups: all, choice, sequence

" Attribute declarations

" Attribute group definitions

® Simple type definitions

® Complex type definitions

® Wildcards: any (limited)

® Type derivation (limited)

® Anonymous types

® Nested element declaration (Russian doll design)

" Separate symbol spaces for elements, types, groups and attribute groups
" Abstract and/or Equivalency classes (limited)

® Target namespace resolver

" xsi:type

® Built-in simple types (primitive; simple derivation such as “restriction”)
® Constraining facets

® Date/time as per ISO 8601

" Import

® Include (limited)
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Unsupported Features

Identity constraints: unique, key, keyref: cannot be translated into XML structure nodes

Block

Built-in simple types (e.g. union)

Regular expressions in data types or patterns (only supported for date/time values)

Substitution group

Recursive data type definition

XML Schema Writer Standards Conformance

Supported Features

Element declaration

Attribute declarations

Model groups: choice, sequence

Nested element declaration (Russian doll design)

Type derivation (limited)

Anonymous types

Simple type definitions

Complex type definitions

Built-in simple types (primitive; simple derivation such as “restriction”)
Constraining facets

Date/time as per ISO 8601 subset

Annotations for XML mapping information

Separate symbol spaces for elements, types, groups and attribute groups

xsi:type (limited)

EntireX XML/SOAP Wrapper
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Unsupported Features

® Other Model groups or group definition (e.g. attribute groups)
® Wildcards: any

® Abstract and/or Equivalency classes (limited)
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Reliable RPC for XML/SOAP Wrapper

Introduction to Reliable RPC

Reliable RPC is used to send messages to a persisted Broker service. The messages are described
by an IDL program and contain only IN parameters. The client interface object and the server in-
terface object are generated from the IDL file, using the EntireX XML/SOAP Wrapper. For the
generation there are no options to set.

Reliable RPC is enabled at runtime. The client has to set the mode for reliable RPC.

For XML/SOAP Wrapper, the only supported mode is AUTO_COMMIT, which commits each message
directly after sending it.

The server is implemented and configured in the same way as for normal RPC.

Writing a Client

The client has to set the parameter exx-reliable in the HTTP header or in the XML/SOAP payload.
See The HTTP Interface for list of supported HTTP headers and parameters.

Broker Configuration

A Broker configuration with PSTORE is recommended. This enables the Broker to store the messages
for more than one Broker session. These messages are still available after Broker restart. The attrib-
utes STORE, PSTORE, and PSTORE-TYPE in the Broker attribute file can be used to configure this
teature. The lifetime of the messages and the status information can be configured with the attributes
UOW-DATA-LIFETIME and UOW-STATUS-LIFETIME. Other attributes such as MAX-MESSAGES-IN-UOQW,
MAX-UOWS and MAX-UOW-MESSAGE-LENGTH may be used in addition to configure the units of work.
See Broker Attributes.
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SOAP and Web Services (Listener for XML/SOAP)

The EntireX XML/SOAP Wrapper supports SOAP version 1.1 and 1.2 and enables you to create
web services easily.

See also Web Services Wrapper.

SOAP Support

The XML Mapping Editor provides a default mapping for SOAP, both for the currently displayed
program as well as for all programs in all libraries of the current IDL file. That is, the latter function
can be used to easily SOAP-enable all programs in an IDL file. See IDL to XML Mapping with the
XML Mapping Editor. The following mapping parameters can be chosen to fine-tune the SOAP
default mapping:

® XML Schema URN for the XML Schema version to be used. This will define the xsd prefix in
the SOAP-ENV:Envelope element, at the beginning of the SOAP message.

® Namespace URI of the “payload” element node (this is the singleton element under the SOAP-
ENV:Body element). Various SOAP toolkits require certain namespace settings. The namespace
prefix will always be “m”.

Note that the SOAP default mapping also works for the “error” direction, where it defines the
“standard” SOAP fault message structure, as described in the specification.

The XML/SOAP Runtime detects whether SOAP is used in incoming messages. If so, the special
elements and attributes of the SOAP specification (SOAP-ENV:Envelope, SOAP-ENV:Body, type,
arrayType etc.) are handled accordingly.

Web Services

Web services are programmable, distributed application components accessible on the Web using
solely standard internet protocols. See Introduction to Web Services in EntireX.

You may create web services with the EntireX Listener for XML/SOAP by wrapping IDL programs
in SOAP message structures, as described in the preceding section, and then generating service
descriptions for them using the WSDL Wizard. The service descriptions use the de facto standard
WSDL (Web Service Description Language) format.

~ To make web services out of your IDL programs

1 Select the IDL file that you want to turn into one or more web services.

2 From the context menu, choose Open With ... > EntireX XML Mapping Editor and choose
SOAP for mapping. Choose Generate.
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3  Setup aservlet engine and configure the Listener for XML/SOAP. See Listener for XML/SOAP.

4 Select the XMM file. Open the context menu and choose Generate Web Service from EntireX
Mapping....

Or:

Select the IDL file. Open the context menu and choose Web Service > Generate Web Service.

5  The generated WSDL file and the deployment unit (AAR file) can be found in the same folder
as the IDL file.

See IDL Extractor for WSDL.
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